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A B O U T  T H I S  M A N U A L
1  A B O U T  T H I S  M A N U A L
Congratulations on the purchase of your new TELES.NMS! This manual is set up to guide you through the step-by-
step use of your TELES.NMS. 

Make sure you familiarize yourself thoroughly with the safety and security precautions detailed in Chapter 2
before you begin using your TELES.NMS. TELES is not liable for any damage or injury resulting from a failure to
follow these safety and security instructions!

1 . 1  O R G A N I Z A T I O N

This manual is organized into the following chapters.

Chapter 1, “About this Manual” introduces the TELES.NMS Manual and how it is set up.

Chapter 2, “Safety and Security Precautions” contains information about security issues relevant to connec-
tion with the IP network.

Chapter 3, “Overview” briefly describes the TELES.NMS and its implementation.

Chapter 4, “NMS Database Copy” describes the application used to copy, convert, import and export 
TELES.NMS MySQL and SQL databases.

Chapter 5, “Server Applications” describes the server applications that regulate access to the common data 
shared by the local host.

Chapter 6, “The NMS Desktop” describes the frontend application that serves as the main NMS workspace.
Chapter 7, “Supplementary Modules” contains a description of additional applications included in 

TELES.NMS.
Chapter 8, “System Data Directories” describes the TELES.NMS directories and their contents.

Chapter 9, “NMS Testing, Polling and Support Procedures” describes how to perform and evaluate tests 
using TELES.NMS.

Chapter 10, “Appendix” contains additional information that may be useful to you.

1 . 2  C O N V E N T I O N S

This document uses the following typographic conventions:

Bold – items from the GUI menu. 
Halfbold – items from the GUI and the menu. 

Code – file names, variables and constants in configuration files or commands in body text.

"conventions" on page 5  – cross-references can be accessed in the PDF files by a single mouse click. 

Configuration data or extracts are written in single-column tables with a gray background.
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A B O U T  T H I S  M A N U A L
1 . 3  S A F E T Y  S Y M B O L S

The following symbols are used to indicate important information and to describe levels of possible danger.

Note

Useful information with no safety implications.

Attention

Information that must be adhered to as it is necessary to ensure that the system func-
tions correctly and to avoid material damage.

Warning

Danger. Could cause personal injury or damage to the system.

Dangerous voltage

Could cause injury by high voltage and/or damage the system.

Electrostatic discharge

Components at risk of discharge must be grounded before being touched.

ii

!!

!!
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S A F E T Y  A N D  S E C U R I T Y  P R E C A U T I O N S

C H A P T E R  2
2  S A F E T Y  A N D  S E C U R I T Y  P R E C A U T I O N S
Please be sure and take time to read this section to ensure your personal safety and proper operation of your
TELES Access Gateway. 

To avoid personal injury or damage to the system, please follow all safety instructions before you begin working
on your TELES Access Gateway.

TELES Access Gateways are CE certified and fulfill all relevant security requirements. The manufacturer assumes no
liability for consequential damages or for damages resulting from unauthorized changes. 

This chapter applies for all TELES Access Gateways. Information that applies only for individual
TELES Access Gateways specifies the system for which it applies.

2 . 1  S A F E T Y  M E A S U R E S

Danger of electric shock - the power supplies run on 230 V. Unplug the TELES Infrastructure System from its power
source before working on the power supply or extension socket. 

Make sure to install the system near the power source and that the power source is easily accessible. 

Bear in mind that telephone and WAN lines are also energized and can cause electric shocks. 

Wire your system using only the cables included in the package contents. Use only proper ISDN and Ethernet cables. 

Do not insert foreign objects into openings in the device. Conductible objects can cause short circuits that result in
fire, electric shock or damage to the device. 

Do not open the TELES Access Gateway except to install an additional TELES component. Changes in the device
are not permitted.

Be sure to respect country-specific regulations, standards or guidelines for accident prevention. 

2 . 2  T I P S  F O R  E M C  P R O T E C T I O N

2 . 3  S Y S T E M  S E C U R I T Y

This section describes all points crucial to the TELES Access Gateway’s system security.

The system’s location must support normal operation of TELES Access Gateways according to EN ETS 300 386. Be
sure to select the location with the following conditions in mind: 

Use shielded cables.
Do not remove any housing components. They provide EMC protection.

Location: Make sure you install the system in a clean, dry, dust-free location. If pos-
sible, the site should be air-conditioned. The site must be free of strong electrical or 
magnetic fields, which cause disrupted signals and, in extreme cases, system failure. !!
7
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S A F E T Y  A N D  S E C U R I T Y  P R E C A U T I O N S

C H A P T E R  2
2 . 4  S E R V I C I N G  T H E  S Y S T E M

Regular servicing ensures that your TELES Access Gateway runs trouble-free. Servicing also includes looking after
the room in which the system is set up. Ensure that the air-conditioning and its filter system are regularly checked
and that the premises are cleaned on a regular basis.

2 . 4 . 1  R E P L A C I N G  C O M P O N E N T S

If your TELES Access Gateway contains any of the following components, replace them according to the following
table:

Temperature: The site must maintain a temperature between 0 and 45°C. Be sure to 
guard against temperature fluctuations. Resulting condensation can cause short cir-
cuiting. The humidity level may not exceed 80%. 
To avoid overheating the system, make sure the site provides adequate ventilation.

Power: The site must contain a central emergency switch for the entire power source.
The site’s fuses must be calculated to provide adequate system security. The electri-
cal facilities must comply with applicable regulations. 
The operating voltage and frequency may not exceed or fall below what is stated on 
the label.
Antenna: iGATE contains no provision or protective device against power surges or 
lightning strikes.
The installation of the antenna must fulfill all necessary safety requirements. Employ 
the services of a professional antenna installer.

Table 2.1  Component Life Span 

Component Life span

Filter pads 6 months

CPU fan (TELES Access Gateways without iLCR Base Board only) 5 years

Power adapter incl. 3.3 V Adapter 5 years

Fan 5 years

Hard disk (IDE) (TELES Access Gateways without iLCR Base Board only) 3 years

!!
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2 . 4 . 2  P R O T E C T I N G  T H E  O P E R A T I N G  S Y S T E M

Changing configuration data may lead to malfunctions and/or misrouting, as well as possible consequential dam-
age. Make changes at your own risk. TELES is not liable for any possible damage resulting from or in relation to
such changes. Please thoroughly check any changes you or a third party have made to your configuration!

Make sure your hard disk or flash disk contains enough storage space. Downloading the log files and deleting them
from the system on a regular basis will ensure your system’s reliability.

Be careful when deleting files that you do not delete any files necessary for system operation.

vGATE Control Unit: 

2 . 5  C D R  F I L E S

Call Detail Records are intended for analysis of the system’s activity only. They are not designed to be used for
billing purposes, as it may occur that the times they record are not exact.

2 . 6  N E T W O R K  S E C U R I T Y

Every day hackers develop new ways to break into systems through the Internet. While TELES takes great care to
ensure the security of its systems, any system with access through the Internet is only as secure as its user makes
it. Therefore, to avoid unwanted security breaches and resulting system malfunctions, you must take the following
steps to secure your TELES Access Gateway if you connect it to the Internet:

Use an application gateway or a packet firewall.

To limit access to the system to secure remote devices, delete the default route and add individual secure
network segments. 

Access to the system via Telnet, FTP, HTTP, GATE Manager or remote vGateDesktop must be password
protected. Do not use obvious passwords (anything from sesame to your mother-in-laws maiden name).
Remember: the password that is easiest to remember is also likely to be easiest to crack.

Do not perform queries on the database. This can result in damages to the database. 
Do not use any MySQL tools, such as MySQL-Front to make changes in or perform 
tests on the database.

vGATE Control Unit:
Do not use Ctrl/Alt/Del (Task Manager) to shut down vGateDesktop or vGATECtrl. Do 
not perform queries on the database. This can result in damages to the database. Do 
not use any MySQL tools, such as MySQL-Front to make changes in or perform tests 
on the database.

Inaccuracies in the generation of CDRs may occur for active connections if traffic is 
flowing on the system while modifications in configuration or routing files are acti-
vated.

!!

!!

ii
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The firewall must support the following features:

Protection against IP spoofing

Automatic recognition of security breaches

Logging of all attempts to access the system
The firewall must be able to check the following information and only allow trusted users to access the
TELES Access Gateway:

IP source address 

IP destination address 

Protocol (whether the packet is TCP, UDP, or ICMP) 
TCP or UDP source port 

TCP or UDP destination port 

ICMP message type 
For operation and remote administration of your TELES Access Gateway, open only the following ports only when
the indicated services are used:

Table 2.2  Default Ports Used for Specific Services 

Service Protocol Port

For all systems except vGATE

FTP TCP 21 (default, can be set)

Telnet (for TELES debug access 
only)

TCP 23

SMTP TCP 25

DNS forward UDP 53

HTTP TCP 80 (default, can be set)

SNTP UDP 123

SNMP UDP 161

H.225 registration, admission, sta-
tus

UDP 1719 (default, can be set)

H.225 signaling TCP 1720 (default, can be set)

Radius UDP 1812 (default, can be set)

Radius accounting UDP 1813 (default, can be set)

GATE Manager TCP 4445 (default, can be set)

SIP signaling UDP / TCP 5060 (default, can be set)

RTP UDP 29000-29120 (default, can be set)
10
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vGATE Control Unit TCP 57343

vGATE tunneling TCP 4446

For vGATE Control Unit and iMNP

FTP TCP 21

Telnet TCP 23

MySQL database TCP 3306

iGATE or TELES.VoIPBOX GSM/
CDMA 4FX to vGATE

TCP 57342

vGATE tunneling to iGATE or 
TELES.VoIPBOX GSM/CDMA 4FX

TCP 4446

iGATE or TELES.VoIPBOX GSM/
CDMA 4FX to iMNP

TCP 9003

Remote vGateDesktop TCP 57344

Remote vGateDesktop (read only) TCP 57345

iMNP TCP 9003

For TELES.vGATE Sim Unit

vGATE Control Unit plus iGATE or 
TELES.VoIPBOX GSM/CDMA 4FX

TCP 51500

For TELES.NMS

FTP TCP 21

Telnet TCP 23

MySQL database TCP 3306

TELES.NMS protocol TCP 5000

TELES.NMS update TCP 5001

TELES.NMS task TCP 5002

TELES.NMS task TCP 5003

Table 2.2  Default Ports Used for Specific Services (continued)

Service Protocol Port
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TELES.NMS Listen TCP 4444

For vGATE Call Manager

Radius authentication UDP 1812

Radius accounting UDP 1813

Connection from a vGATE Control Unit to a iGATE or iGATE requires ICMP access. The 
TCP filters listed above are activated in the default configuration of the vGATE Con-
trol Unit or the TELES.NMS server.

Table 2.2  Default Ports Used for Specific Services (continued)

Service Protocol Port

ii
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3  O V E R V I E W
The TELES Network Management System of-
fers automated remote administration, testing
and maintenance services for TELES infrastruc-
ture systems.

TELES.NMS can automatically monitor up to
100.000 individual systems (or network ele-
ments). The basic TELES.NMS configuration
runs on a single computer running
Windows 2000. 

TELES.NMS manages the central database
with the information on each network ele-
ment. It runs the Windows 2000 Professional
operating system, MySQL Server software and
all applications included with TELES.NMS.

You can also install a TELES.NMS client on a remote PC. The installation is described in Chapter 10.4  of this
manual. 

3 . 1  W H A T ’ S  N E W  I N  V E R S I O N  1 4 . 0

SIP callback possible

Now retrieves and displays VoIP statistics
Self-provisioning of all TELES Access Gateway devices now possible with NMSJobs

NMS

NMS
Client

IP Network

PSTN
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3 . 2  F E A T U R E S

Supports self-provisioning of all TELES Access Gateways

Supports second generationTELES Access Gateways, such as iGATE GSM, iGATE CDMA, iGATE UMTS,
VoIPBOX BRI.

TELES.NMS Listen available over IP with second generation systems.
A MySQL Server provides access to the common database via the ODBC interface.

TELES.NMS offers three methods for confirming the operational status of tested systems:

– Periodic automatic testing (NMS dials the systems)
– Regular status notifications from each system (polling)

– Support calls from systems in case of errors

The testing interval for each system can be individually set.
If a tested system returns error messages, TELES.NMS can place an automatic emergency message to a
pre-selected e-mail address (operator alarm).
The network element’s log file is automatically picked up for easier error diagnosis. 

Individual tested systems may be marked as especially crucial (VIP) and assigned to groups for a better
overview.

The NMS Desktop application displays tested systems in various views, allowing you to concentrate on
particular systems while maintaining an overview even with a large network. The Group View, Error
View, VIP View, Update View and Full View windows can show network elements as icons or as a
detailed list.

The NMS Jobs module is used to define and manage recurring maintenance tasks. Defined jobs can be
used to automatically trace ISDN activities, restart systems, transfer files and routing tables and update
software using one of four different recurrence patterns. Actions can be carried out once (non-recurring
job), cyclically, daily and monthly.
The EventViewer2 keeps a record of NMS communication activities using an automated logging feature.
The application tracks the errors selected in the EventManager that take place during communication
14
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between NMS and network elements, such as systems that cannot be reached, or for which the password
is incorrect. (The error history for individual tested systems is viewed separately from the NMS Desktop)

The Update Management features allow automatic system installation, setup and configuration.
Complete call data log automatically transferred to NMS from TELES.iLCR 1BRI Boxes, TELES.iLCR
2BRI Boxes, and iLCR 6BRI Boxes or picked up by NMS from VoIPBOX BRIes, iGATEs and VoIPGATEs.
Possibility to use the same routing files for different system types

Definition of iLCR port error categories

Group based time zone support
Group based testing possible

NMSEventManager allows selection of events to save, send alarm messages and display in the
EventViewer2

NMS User Manager allows selection of user rights for security

CDRs can be saved in the database or in a file
For all second generation systems and for first generation systems with an integrated iLCR IP Board, all
TELES.NMS functions can be performed over IP. 4 B channels can be used for testing over IP or 2 B channels
per ISDN board can be used for testing over IP and ISDN.
15
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3 . 3  S Y S T E M  R E Q U I R E M E N T S

3 . 3 . 1  P C  F O R  T E L E S . N M S

3 . 3 . 2  TE S T E D  S Y S T E M S  ( N E T W O R K  E L E M E N T S )

On each of the network elements, the dial-in number for NMS testing must be active (MapIn to remote adminis-
tration). Remote administration must be configured. (For information on other specific configuration prerequisites
for each system type, see Chapter 4.3 ). Table 3.4  lists each supported system type and the version number
capable of cooperation with TELES.NMS.

Table 3.3  TELES.NMS PC Configuration 

Component NMS Server

Operating system Windows 2000 Professional, Service Pack 4

Processor Intel Pentium IV 2.40 GHz

Memory 512 MB PC133 RAM

Hard drive 60 GB (boot)

ExelStor J360

Graphics card 8 ATI RAGE XL PCI

Ethernet adapter Intel (R) Pro/100

Network protocols TCP/IP

ISDN Adapter HST Saphir III (BRI)

HST Saphir IV (PRI)

ISDN Driver HST Dual CAPI

ISDN Line Point-to-Multipoint
Point-to-Point

Database Components MySQL ODBC 3.51

MySQL Server 4.0.22
16
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3 . 4  TE R M S  &  C O N C E P T S

This section explains some of the terminology and concepts that are central to understanding the TELES.NMS soft-
ware. 

3 . 4 . 1  N M S  TE S T I N G ,  P O L L I N G  A N D  S U P P O R T  C A L L S

NMS Testing

During NMS testing, TELES.NMS places calls to network elements to verify their operational status. The NMS
Desktop application calls the dial-in number for NMS testing specified in each system’s configuration file. The sys-
tem only accepts ISDN calls to this number when errors have occurred. In this case, the event log file is picked up.
Otherwise, the system sends an alerting signal to tell TELES.NMS that it is still operational, and NMS then discon-
nects the call. This type of testing may be initiated from the NMS Desktop by clicking the Start Testing button on
the toolbar. All systems for which the Test cyclically option has been marked in the system editor are dialed se-
quentially during cyclic testing.

Individual network elements may be tested by hand using the Start single test command from the context menu
available in certain NMS Desktop views.

NMS testing can also be performed automatically on a certain group of systems using the NMS Jobs application.
The Test system command can be activated from the Commands tab of the NMS Job Editor.

NMS testing is also available using IP. TELES.NMS sets up an IP connection to the system.

Table 3.4  NMS-Capable TELES Infrastructure Systems

System Type Version

All second generation systems as of 11.6d

iGATE as of 5.10

iGATE-C as of 6.10

TELES.iLCR 1BRI Box as of 1.0

TELES.iLCR 2BRI Box as of 2.15

iLCR 6BRI Box as of 1.0

iLCR PRI Box as of 3.03

iLCR System as of 3.01g

VoIPGATE as of 6.00
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Polling

TELES infrastructure systems dial in to the NMS Listen application at a specified interval to signal their operational
status. This so-called polling call shows TELES.NMS that the system is still up and running, and offers the oppor-
tunity for further actions such as routing table updates, etc. If updated routing tables are available and the update
table flag has been set for the selected system(s) in the NMS Update View, the new tables will be transferred to
the system at this time. 

You can poll second generation systems over IP connection using the command RemoteCallback=<ip address
of the TELES.NMS server> <time> <daymap>.

For PC-based systems such as iLCRs, iGATEs and VoIPGATE systems, both the TELES.NMS number and interval at
which the calls should be placed are entered into the configuration file using the RemoteCallback=number
time day command. Box-based systems use two separate commands to make these settings. The
NMSPollNumber defines the number to be dialed, and the frequency with which such calls are placed is defined
using either the NMSPollInterval or CallbackFrequency entry. 

Support Calls

Network elements can be configured to contact TELES.NMS when errors occur. These support calls also connect
the system to the NMS Listen application, but a different number is dialed (not the same number used for regular
polling calls). PC-based systems define this support number using the AlarmCallBack command, whereas box-
based units use EmergencyNumber.

Most TELES infrastructure systems dial the support number after power failure or other malfunction. iLCR Boxes
use this number to pick up a table each time they are connected to the power supply. During this connection the
system transfers the event log to TELES.NMS and receives a new routing table if necessary. When answering calls
at this number, the NMS Listen application always holds the connection and picks up the event log.

Support calls from second generation systems can also occur via IP using the command AlarmCallBack=<ip
address of the TELES.NMS server>.

The support number is also dialed by TELES.iLCR 1BRI, 2BRI, 6BRI, and iLCR PRI Boxes when the box’s Call Detail
Recording (or CDR) buffer is 66% full. The NMS Listen application accepts the incoming call and receives the call
data. The program keeps the connection open while the file is converted to ASCII format and saved as
CHA_0101991255_0.log in the system’s Charges directory of the NMS folder hierarchy (cf. Chapter 8.2 on
page 83 ). Once the file has been successfully converted and saved, the program signals the system to delete
this portion of the memory and terminates the connection. 

3 . 4 . 2  F A U L T  M A N A G E M E N T

The term fault management refers to the three methods of confirming the operational status of tested systems de-
scribed above in the section on NMS Testing, Polling and Support Calls .

3 . 4 . 3  U P D A T E  M A N A G E M E N T

Update management is the term used to describe the process of ensuring that network elements operate using
consistent and up-to-date routing information by automatically sending current routing tables to systems as need-
ed.
18
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3 . 4 . 4  J O B  M A N A G E M E N T

The job management process consists of routine maintenance tasks that can be carried out automatically by de-
fining jobs to be executed on selected systems at a pre-determined time. (In previous versions of TELES.NMS, the
word tasks was used interchangeably with jobs.) The responsibilities for this process are distributed between three
applications. 

The NMS Jobs application is used to define the actions that are to be performed, determine when the job is to be
run and which systems the job shall be executed on. The NMS DoJob program is responsible for carrying out the
assigned jobs at the designated time. This application must be running on all workstations from which automated
maintenance tasks are to be performed. The NMS JobServer application runs on the NMS server and coordinates
the job management activities of all NMS workstations.

3 . 4 . 5  A U T O M A T I C  R E G I S T R A T I O N

When an unknown system connects to TELES.NMS, the NMS Listen application can create database entries for the
new system and supply the network element with appropriate configuration and routing information based on the
system type and/or area code, etc. This procedure is referred to as automatic registration.

In order to make use of this feature, a standard group for new systems must be selected on the General tab
of the NMS Configuration (advanced) dialog. In the NMS Desktop properties dialog (Groups tab), the Update
management option must be active for this group and the Automatic registration to update management
option must also be selected.

Second generation systems are entered in the database with their IP addresses and tag numbers as serial numbers.
The TAG number is automatically entered as the routing directory. We recommend that you register these newer
systems via IP and not via ISDN.

Configure the commands RemoteCallback=<ip address of the TELES.NMS server> <time> <daymap> and
AlarmCallBack=<ip address of the TELES.NMS server> directly after the Subscriber section in the
pabx.cfg and restart the system.

3 . 4 . 6  S E L F - P R O V I S I O N I N G

Self provisioning is possible for all TELES Access Gateway devices. The variable data for configuration are saved in
a transfer database in the TELES.NMS MySQL server. The name of the database is NMSInputConfig. The name
of the table is inputconfig. We recommend that you write the data into the database using an SQL script.
TELES.NMS transfers the data into the TELES.NMS database cyclically every 10 minutes and deletes the transferred
data from the transfer database. A protocol of the data transfer is saved in the directory
\\nms_data\Logging\Provisioning.

Only one set of data can be generated for each serial number. Existing data sets can be changed by updating them.

The provisioning data must appear in the NMS database inputconfig and the CFGs in the files pabx.cfg, route.cfg
and ip.cfg in one of the following directories:

\\nms_data\Systemtypes\SystemTypeString\Provisioning\

or:
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\\nms_data\Systemtypes\SystemTypeString\Systems\
System-Name\Provisioning\

Bear in mind that configuration file settings are usually customized. Therefore it may be necessary to change the
provisioning process according to your needs. Table 3.5  contains a description of the data feed: 

Table 3.5  Self-Provisioning Data Feed 

Column Description

AutoId Automatically generated data set identification.

SerialNumber A string consisting of the system’s TAG number.

SystemType A 12 will appear for VoIPBOX BRI.
RemotePassword The password for remote access appear in cleartext.

IPAddress Appears in the following format:
<IPaddr>/<mask>

Gateway Lists the gateway’s IP address.

Customer Lists either the customer’s name or CPE number.

CountryCode Customer’s country code.

AreaCode Customer’s domestic area code.

OwnNumbers Appears in the following format:
<port>:<num>
Multiple numbers can be separated by a comma. To define a range, use the 
following format:
<port>:<from>-<to>

SIPUser The SIP username appears here.

SIPPwd The SIP password appears here.

BRICount Lists the number of BRI ports.

FXCount Lists the number of analog ports (0).

MobileCount Lists the number of mobile ports (0).

MobileType Type of mobile port (0)

PRICount Lists the number of PRI ports (0).

VoIPChannels Lists the number of VoIP channels (8).
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Example: The following script example shows how values are set for self-provisioning:  

Save the script on the NMS server.

Example: E:\inputscript\inputconfig.sql
To carry out the script, open the command window and change the directory to: 

D:\mysql\bin>

Log onto the Mysql server with: mysql -u nmsuser -p

The password is: nms

PtsnTE Lists the connection type for the BRI ports:

0=NT
1=TE

EXAMPLE: 0011 means that the first to BRI ports are TE and the last 2 are 
NT. Mobile ports are not counted. Enter a 3 in the script to set BRI ports 1 
and 2 to TE. That is the sum of the set bits in decimal notation (8421=1111).

PtsnPP Lists whether the PP or PMP protocol is used on the BRI port:
0=PMP

1=PP

Mobile ports are not counted. Enter a 3 in the script to set BRI ports 1 and 
2 to PP. That is the sum of the set bits in decimal notation (8421=1111).

InhibitNumbers Lists blocked numbers, separated by a comma.

PrimOutProf Name of the primary outgoing profile.

VoIPCodecs Lists possible VoIP codecs. Default empty.

Advanced Shows a description of advanced functionality.

DELETE=delete the configuration information in the NMS database
SYSTEMDELETE=delete the system from the NMS database

RouteToPtsn Contains a list of numbers, separated by a comma, that are always routed to 
the backup ports (TE).

USE nmsinputconfig;

INSERT INTO inputconfig 
(SerialNumber,SystemType,RemotePassword,IPAddress,Gateway,Customer,CountryCode,AreaCode,OwnNumbers,SIPUs
er,SIPPwd,BRICount,FXCount,MobileCount,MobileType,PRICount,VoIPChannels,PtsnTE,PtsnPP,InhibitNumbers,Pri
mOutProf,VoIPCodecs,Advanced,RouteToPtsn) VALUES('TAG58011111111111',12,'','192.168.0.110/
24','192.168.0.100/24','Muster1','+49','030','3:123-129; 4:567-569','voipbox1','voipbox1',4,' ',' ',' ',' 
',8,3,3,'0190,0180','due','g729,t38','','771,772,773');

Table 3.5  Self-Provisioning Data Feed (continued)

Column Description
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Enter \. followed by the path for the script saved on the TELES.NMS server: 
\. E:\inputscript\inputconfig.sql

Now the data will be written into the nmsinputconfig database. Within ten minutes, the data will be transferred
to the TELES.NMS database. When the systems connect to TELES.NMS, they will be configured automatically.

3 . 4 . 7  S E C U R I T Y  M E A S U R E S

As the TELES.NMS software is used to manage mission-critical systems and sensitive customer data, a multi-level
security concept is built into the software’s architecture to prevent unauthorized use. 

3 . 4 . 7 . 1  U S E R - L E V E L  S E C U R I T Y

There are three levels of user-level security built into TELES.NMS.

The TELES.NMS User Manager allows you to custom select which users have access to each of the TELES.NMS pro-
grams. You can also use this program to assign specific rights to each user. For a detailed description of the
TELES.NMS User Manager, please see Chapter 7.3 on page 62 .

3 . 4 . 7 . 2  S O F T W A R E - L E V E L  S E C U R I T Y

There are three layers of software-level security built into TELES.NMS. 

1. The Windows 2000 Professional operating system used for the NMS Server computer limits access to net-
work users explicitly granted permission by the network administrator. 

2. If this additional security measure has been activated in the Server group on the Security tab of the
NMS Configuration module, each module that attempts to connect to the NMS Server software must
provide the proper password or access will be denied. (This password is assigned for each workstation.)

3. If the MySQL Server Integrated security option is selected on the Security tab of the NMS Config-
uration module, an additional password is required to access the MySQL Server software.

3 . 4 . 7 . 3  D A T A  S E C U R I T Y

The NMS Server computer is shipped with four hard disks. A single 60 GB disk is formatted with the following par-
titions:

Drive C – 5000 MB W2000 NTFS primary
Drive D – 20 GB NTFS logical including MySQL Server and TELES.NMS software

Drive E – 5000 MB NTFS logical 

Drive F – approx. 30 GB MySQL database

The TELES.NMS server and NMS Listen must be running and the self-provisioning flag 
must be set (cf. Table 6.12 on page 42 ).ii
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4  N M S  D A T A B A S E  C O P Y
The NMS Database Copy application is used to copy, convert, import and export TELES.NMS MySQL and SQL
databases. Check to be sure that both the source and the destination databases are configured as ODBC System
DSNs using the NMS Configuration module or the ODBC Data Source Administrator from the control panel.

To convert your database, start NMS Database Copy and proceed as follows:

1. From the Source Database list, select the database from which you would like to extract information.
(This list shows all System DSNs configured on your computer. If the desired data source is not shown in
the list, follow the instructions in Chapter 10.4.3 on page 96  for setting up data sources with System
DSNs.)

2. From the Destination Database list, choose the database into which you would like to import the
information. (This list shows all System DSNs configured on your computer. If the desired destination
database is not shown in the list, follow the instructions in Chapter 10.4.3 on page 96  for setting up
data sources with System DSNs.)

3. Begin copying by pressing the Copy Database button.
4. The current contents of the destination database will be deleted when new information is copied to an

existing database. If you are sure you want to proceed, confirm the prompt by clicking Yes. (To cancel
the copy procedure, click No).

Database copies should only be made offline to ensure that the database is written 
correctly.

Figure 4.1  The NMS Database Copy Window

ii
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4 . 1  N M S  C U S T O M E R  C O P Y

The NMS Customer Copy application is similar to the NMS Database Copy application described in
Chapter 4 . Whereas the Database Copy tool is used to copy entire databases in offline mode, the Customer
Copy module is intended for importing new and changed entries into the current NMS database while the system
is running.

To update your database, start NMS Customer Copy and proceed as follows:

1. From the Source Database list, select the database from which you would like to extract information.
(This list shows all System DSNs configured on your computer. If the desired data source is not shown in
the list, follow the instructions in Chapter 10.4.3 on page 96  for setting up data sources with System
DSNs.)

2. The Destination Database shows the current NMS database (as selected in the NMS Configuration
application) into which the information will be imported.

3. In the Copy Mode group, select the Overwrite option to change existing entries if the source database
contains identical entries. Mark the Append option to add new entries to the database.

4. Begin copying by clicking the Copy Database button.

Figure 4.2  The NMS Customer Copy Window
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4 . 2  N M S  C O N F I G U R A T I O N

There are two NMS Configuration modules supplied with the software. The Advanced module offers all of the
options described below and is intended for the initial configuration of server systems. The Client module is limited
to the network and security settings required for NMS workstations. Use the appropriate application for the system
you are setting up and adjust the default settings to meet your needs.

Table 4.6  NMS Advanced Configuration 

Option Purpose

General Tab

Group A list of pre-defined groups is provided in the drop down list field. Unless you are im-
plementing a configuration with NMS resources distributed across the network, leave 
the default value (NMC) unchanged.
The group ID is shown to the left of the group name.

ODBC

data source name

If a data source has already been configured as a System DSN in the ODBC Data 
Source Administrator, you can simply select the desired name from the list shown 
here.
If you have not yet created a database entry in the ODBC driver list, press New. (See 
the instructions in Chapter 10.4.3 on page 96 .) To alter the settings for the cur-
rent database, use the Edit button. If a different data source is selected here, all ap-
plications must be restarted, so that they will work with the newly selected database.

Own number This setting defines the telephone number which should be sent to tested systems 
from this workstation as the calling party number. (If network elements’ configura-
tions contain RemoteOrigination entries, the number entered here must agree 
with one of the specified numbers.)

Global password If entered, this password is saved as the remote administration password for new sys-
tems in the database.

Outside line access If the workstation is connected to a PBX and you must dial a digit (such as 9 or 0) to 
access the public telephone network, enter that digit here (applies to the current PC).

Use outside line 
access

Mark this option to prefix the digit specified above to all outgoing calls placed from 
the current PC.

Start desktop without 
CAPI functions

Select this option when installing on TELES.NMS clients that are not allowed to run 
NMS testing and remote administration.

Standard group for new 
systems

Specify the default group to which new systems should be assigned when they are 
automatically added to the database.

Network Tab

Server group
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Update port TCP port number used for communication between the NMS centers to update the 
common database maintained by the NMS Server. The default settings usually need 
not be altered.

Protocol port TCP port number used for communication between the NMS centers to update the 
common database maintained by the NMS Server. The default settings usually need 
not be altered.

Network timeout Maximum time (in seconds) the system should wait for client response. The default 
settings usually need not be altered.

Server name Name of the computer containing the NMS Server. If this server module is running on 
the local system, enter localhost. 
If the current system is to be operated as an additional workstation or client, enter 
the name of the computer running the database and the server.

The server name is resolved to an IP address using the Domain Naming System (DNS). 
If no DNS server is available, a hosts file must be created in the system directory. This 
file should contain IP addresses and computer names separated by tabulators.

Maximum clients Maximum number of clients that may be connected to the NMS Server application.

Event Mail group

SMTP Server Enter the name of the SMTP server from which alarm messages are sent.

SMTP Server1 (reserve) In this box, you can enter the name of a reserve SMTP server, which will send alarm 
messages if the default server fails.

SMTP Originator Enter the e-mail address that sends alarm messages.

Logon group (activate if server requires logon information)

User Name Enter the user name.

Password Enter the account’s password.

Base64 encoding Click here to activate or deactivate password encoding.

Server Tab

Synchronize time If this option is active, the time settings of all NMS computers in the center are syn-
chronized every minute. This process is also used to verify client operation.

Maximum test duration If a system test cannot be completed successfully within this time limit, TELES.NMS 
will automatically end the test.

Test all systems in day-
time mode

If all network elements selected for testing should be tested during daytime mode, 
mark this option.

Table 4.6  NMS Advanced Configuration (continued)

Option Purpose
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Maximum test 
frequency

Enter a delay in minutes after which TELES.NMS should repeat the test cycle. A new 
cycle begins once all systems are tested and the time set here has expired. 

Events group

Log events also in 
WinNT-Event Log

Check this box if you would like events to be saved in the WinNT-Event Log.

Delete events older Enter a value in hours after which you would like events to be deleted.

Save before delete Check this box if you would like events to be saved before they are deleted.

CDRs group

Save CDRs in Database When this option is active, CDRs will be saved in the database.

Delete CDR Files Click here to delete saved CDRs.

Mode group

Standard mode In daytime mode, every network element in the database is tested if the Test all sys-
tems in daytime mode option is marked above. If the above option is not selected, 
only NMC systems are tested during the daytime. In night mode, NMS tests only net-
work elements for which the At night option is marked in the NMS System Editor. 

Active mode All systems are constantly tested. Daytime and night mode settings are irrelevant.

Inactive mode The server is deactivated and does not test any systems. Access to the database is not 
allowed.

Traces Select the messages you would like displayed in the server dialog:

Debug All server activities 
Warning All warnings 

Error All errors

Synchro. Every synchronization

Buffer Enter the number of lines you would like to save in the error buffer. 
Once this limit is reached, old messages are overwritten by new infor-
mation 

Security Tab

Database group

Windows NT 
integrated

Login to the MySQL server takes place via the Windows 2000 network login. The 
same password and user name must be used for both Windows 2000 and for the 
MySQL server.

SQL Server 
integrated

Separate logons are used for Windows 2000 and the MySQL server. The default user 
is nmsuser and the default password is nms.

Table 4.6  NMS Advanced Configuration (continued)

Option Purpose
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4 . 2 . 1  T H E  C L I E N T  C O N F I G U R A T I O N  M O D U L E

The Client configuration module contains only the network and security settings required for NMS workstations: 

User name Login name for the MySQL server (nmsuser).

Password Password for the MySQL server (nms).

Check security Verifies whether the current security settings allow database access.

Server group

Require 
authorization

Mark this option if security clearance is required between the NMS Desktop applica-
tions and the NMS Server. (inactive by default) If this additional security is desired, 
check the box and supply user name and password in the fields provided below. 

User name Login name for the NMS Server.

Password Password for the NMS Server.

Directories Tab

Working directory The current working directory is displayed in this text field. Use the name server so 
select another directory. If you do not have a name server, you can enter the IP ad-
dress into the Working Directory dialog box using the following format:

\\192.168.1.1\nms_data

Browse All Press this button to view the entire directory tree structure of the local system and 
select a working folder.

Browse Share Press this button to view the local system’s shared directories and select a working 
folder.

Use this configuration only on NMS workstations.

Table 4.6  NMS Advanced Configuration (continued)

Option Purpose

ii
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4 . 3  C O N F I G U R I N G  N E T W O R K  E L E M E N T S  F O R  N M S  TE S T I N G

4 . 3 . 1  S E C O N D  G E N E R A T I O N  I G A T E ,  V O I P G A T E  A N D  V O I P B O X B R I

In the case Second-generation iGATEs, VoIPGATEs and VoIPBOX BRIes all tests, polling and support settings occur
via IP.

For each system that is to be tested, the following entries are required in the configuration file:

Remote Administration 

Configure remote administration. A password and up to eight permitted numbers can be specified. 

Polling & Support Settings

Second-generation iGATEs, VoIPGATEs and VoIPBOX BRIes poll TELES.NMS at a specified interval to signal their
operational status. This shows TELES.NMS that the system is still up and running, and offers the opportunity for
further actions such as routing table updates, etc. Both the TELES.NMS number and the time and day at which the
calls should be placed are entered into the configuration file using the RemoteCallback=<ip address of the
TELES.NMS server> <time> <daymap> command.

When the system malfunctions, the support connection is set with AlarmCallBack=<ip address of the
TELES.NMS server>. 

Table 4.7  NMS Client Configuration 

Option Purpose

Network Tab

Server name Name of the computer containing the NMS Server. If this server module is running 
on the local system, enter the server’s IP address. You must then restart the server.

If the current system is to be operated as an additional workstation, enter the IP 
address of the computer running the database and the server.

The server name is resolved to an IP address using the Domain Naming System 
(DNS). If no DNS server is available, an IP address must be entered in the system 
directory.

Security Tab

Require 
authorization

Mark this option if security clearance is required between the NMS Desktop appli-
cations and the NMS Server. (inactive by default) If this additional security is desired, 
check the box and supply user name and password in the fields provided below. 

User name Logon name for the NMS Server (nmsuser).

Password Password for the NMS Server (nms).
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Routing Table and File Transfer

Certain conventions must be observed with regard to file names on second-generation iGATEs, VoIPGATEs and
VoIPBOX BRIes in order to ensure proper automatic file transfer via NMS Jobs and the update management ser-
vice. 

To ensure proper file transfer, the PABX.CFG must also define the following:

the charge file with the Log=[directory]cdr.log entry

the trace file using the TraceLog=[directory]trace.log entry 
the error file as ActionLog=[directory]protocol.log
the failed file as RRufLog=[directory]failed.log

When the NMS Jobs module transfers files, the software searches for files by name. Therefore, the names of these
files may not be altered. 

The RemotePassword can be configured with the MKPWD program (see the appropriate Systems Manual).

Example: TELES.NMS connects to the system via ip at 11:00 p.m. for test purposes. The following entries
in the PABX.CFG are necessary:

4 . 3 . 2  I L C R  A N D  F I R S T  G E N E R A T I O N  I G A T E

iLCR and iGATE systems must be configured with certain specific parameters in order to ensure their cooperation
with the TELES.NMS testing processes. 

All tests and remote connections can occur via IP if the system contains a iLCR IP Board or a iLCR VoIP Board. For
information on how to configure the system, please refer to the appropriate systems manual.

For each system that is to be tested, the following entries are required in the configuration file:

Remote Administration 

Configure remote administration. A password and up to eight permitted numbers can be specified. The remote
origination numbers entered must include the numbers of the Network Management System. Map the dial-in num-
bers for remote administration to the virtual remote administration numbers (RemoteCode=BBB).

The iLCR/iGATE drivers must be called in the AUTOEXEC.BAT so that they are automatically loaded when the
iLCR or iGATE is restarted via remote administration.

Dial-In Number for Testing

Map the dial-in number for NMS testing to the virtual remote administration numbers with an asterisk (‘*’) added
at the end. The system only accepts calls to this number when errors have occurred. In this case, the event log file
is picked up. Otherwise, the system sends an alerting signal to tell TELES.NMS that it is still operational, and NMS
then disconnects the call. 

RemoteCallback=192.168.0.1 23:00 11111111 ; NMS polling 
AlarmCallBack=192.168.0.1 ; NMS support 
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Activate the system’s event log feature using the ActionLog command. The log file name must be configured
as protocol.log, as the NMS software will retrieve only the file with this name. The remote administration
numbers and test numbers must be within the system’s number block. The cascaded PBX cannot use these num-
bers for data transfer.

Polling & Support Settings

iLCRs and iGATEs dial in to TELES.NMS at a specified interval to signal their operational status. This so-called “poll-
ing” call shows TELES.NMS that the system is still up and running, and offers the opportunity for further actions
such as routing table updates, etc. Both the TELES.NMS number and the time and day at which the calls should be
placed are entered into the configuration file using the RemoteCallback=number time day command.

When the system malfunctions, the support number set with AlarmCallBack=number is dialed instead. 

Routing Table and File Transfer

Certain conventions must be observed with regard to file names on <lowercase>iLCR and iGATE systems in order
to ensure proper automatic file transfer via NMS Jobs and the update management service. Two different methods
may be used to store routing information, but in each case, the prerequisites must be met and the routing config-
uration type must be properly distinguished using the corresponding option in the System Editor (cf. Chapter 6.2
on page 44 ).

a) On older systems, time-dependent routing information may be stored directly in the PABX.CFG file. As
this method was common up to TELES.NMS Version 1.3, this configuration is assumed for systems import-
ed from Version 1.3 databases, and the New configuration type (routing) option is left unmarked in
the System Editor dialog.

b) For newer systems, time-dependent routing information is commonly stored in a separate file. In this case,
the PABX.CFG must contain the PermanentFile=route.cfg entry. The route.cfg must then
define the time-dependent routing files using ExternFile= [directory\filename...] entries. For
newly created systems, this method is assumed and the New configuration type (routing) option is
marked in the System Editor. NMS does not check the correctness of the entries nor does it attempt to
determine whether or not the ExternFiles are present. In order to automatically update routing in-
formation, each number range subdirectory must contain a route.cfg file and all of the files defined
therein with ExternFile entries. 

To ensure proper file transfer, the PABX.CFG must also define 

the charge file with the Log=[directory]charge.log entry

the trace file using the TraceLog=[directory]trace.log entry, and 

the error file as ActionLog=[directory]protocol.log.

When the NMS Jobs module transfers files, the software searches for files by name. Therefore, the names of these
files may not be altered. 

Example: TELES.NMS dial in to the system at 040 222 3589 for test purposes. Remote administration is
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configured for 3588. The following entries in the PABX.CFG are necessary:

4 . 3 . 3  I L C R  X B R I / P R I B O X E S  

iLCR XBRI/PRI Boxes must be configured with certain specific parameters in order to ensure their cooperation with
the TELES.NMS testing processes. For each system that is to be tested, the following prerequisites must be met:

Remote Administration 

Configure remote administration in the configuration table by specifying a password (RemotePassword) and
up to three numbers from which remote administration should be permitted (RemoteOrigination). The re-
mote origination numbers entered must include the numbers of the Network Management System. 

Dial-In Number for Testing

Map the dial-in number for NMS testing to the virtual remote administration numbers with an asterisk (‘*’) added
at the end. The system only accepts calls to this number when errors have occurred. In this case, the event log file
is picked up. Otherwise, the system sends an alerting signal to tell TELES.NMS that it is still operational, and NMS
then disconnects the call. 

Polling & Support Settings

Box-based systems dial in to TELES.NMS at a specified interval to signal their operational status. This so-called
“polling” call shows TELES.NMS that the system is still up and running, and offers the opportunity for further ac-
tions such as routing table updates, etc. Depending on the version number, different settings are necessary to de-
termine the polling interval for the iLCR XBRI/PRI Boxes:

For dialer devices before version 3.01, the RemoteCallback parameter defined only the number for
NMS polling.
As of version 3.01, the NMSPollNumber parameter is used to specify the number.

In both cases, the NMSPollInterval command determines the interval at which the RemoteCallback or
NMSPollNumber should be dialed. 

As of version 3.01 the EmergencyNumber defines the support number to be called after critical errors such as
power loss, etc. have occurred. 

RemoteCode=3588
MapIn3588=3588 DATA
MapIn3589=3588* DATA 
RemotePassword=TTV6
ActionLog=protocol.log
RemoteCallback=90303992800 15:00 00000001
AlarmCallBack=00303992801

The RemotePassword must be configured with the MKPWD program (see the corre-
sponding Systems Manual).ii
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The following configuration table entries are necessary:

NMSPollNumber=90800123456 ; number for polling calls to NMS Listen
; 9 is dialed for an outside line, 
; 0800123456 is the NMS polling number 

NMSPollInterval=168:00:00 ; determines how often above number is dialed 
; (in hhh:mm:ss format, here once per week)

EmergencyNumber=90800123457 ; number for support calls to NMS Listen
; 9 is dialed for an outside line, 
; 0800123457 is the NMS support number 
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5  S E R V E R  A P P L I C A T I O N S
The TELES Network Management System makes use of several server applications that regulate access to the com-
mon data shared by the local host. These programs run on the server computer and ensure the proper operation
of the entire network. The server applications provide essential services to the other program modules. 

5 . 1  N M S  S E R V E R

The NMS Server application (nmsserver.exe) runs on the computer that maintains the common database
and is responsible for synchronizing database access and coordinating TELES.NMS testing procedures. Before each
action and every database access attempt, the NMS workstation asks the server for permission to carry out the
desired task. If a system’s database entry changes, the server informs all NMS workstations of the change.

The NMS Server application can be started by double-clicking the corresponding desktop icon. When the program
is running, an NMS Server icon appears in the taskbar. When you move the mouse pointer over the taskbar icon,
a tooltip message shows whether the NMS Server is active.

Right-clicking the taskbar icon displays a context menu with the following selection: Trace…, Options…,
About… and Exit. Double-clicking the icon has the same effect as choosing Trace… from the context menu. In
either case, the following window appears:

The menus in the NMS Server dialog correspond to the options available from the context menu. The File menu
is used to save and delete trace information and to quit the Server application. The Options menu displays the
Server tab from the NMS Configuration module (cf. Table 4.6 on page 25 ). Help/About… shows informa-
tion such as program version number, memory and drive capacity.

NMS center name Number 
of clients 
connected

Mode Status Time since start [dd:hh:mm]

Figure 5.3  The NMS Server Window
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5 . 2  N M S  J O B S E R V E R

The NMS JobServer application keeps track of running jobs and manages jobs executed by the NMS DoJob ap-
plications running on the NMS workstations.

The module’s interface consists of a window with trace information similar to the NMS Server window. The File
menu allows you to save or delete the trace information and exit the program. The Options menu contains the
commands used to stop tracing and offers a selection of trace information to be displayed.

The Info command opens a window displaying an overview of all defined jobs and their current status. The Help
menu shows version and memory information.

Table 5.8  NMS JobServer Options Menu

Option Purpose

Deactivate Stops the server from distributing systems for job processing. All jobs cur-
rently running on network elements are completed for those systems, but no 
new systems are processed by any of the active jobs.

Distribution Delay Select the delay that should be used between the completion of an active 
job on one system and the execution of that same job on the next system. If 
None is selected, the job will immediately be executed on the next system. 
Otherwise, the server will wait 1–5 seconds before assigning the next sys-
tem.

Pause Between Tries This delay regulates the period of time that elapses before a job is re-execut-
ed on a system if it could not be successfully repeated on the first attempt.

Trace Debug Info Include debug messages in the trace window

Trace Warnings Include warnings in the trace window

Trace Errors Include error messages in the trace window

Figure 5.4  The NMS JobServer Window
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6  T H E  N M S  D E S K T O P
The NMS Desktop application
serves as the main NMS work-
space.

After the password is entered,
the NMS Desktop window ap-
pears with the following menus:

The File menu contains
only the Exit command
used to close the program.
The Edit menu appears
only if the Dynamic
Groups window is active.
The menu offers standard
commands for working
with dynamic groups
including Open Group,
New Group, Edit Group,
Rename Group, Delete
Group and Find. 

The View menu contains the option for displaying or hiding the toolbar and status bar and two commands
which affect the way information is displayed in the panes in the lower portion of the main dialog. Both
of these options are active by default.
– Mark the Gridlines option to display the row and column boundaries on each of the panes in the

main dialog. 
– The Full Row Select option highlights the entire row when information in one of the columns is se-

lected. 
The Window menu contains options for displaying different NMS view windows. Each active window is
listed in this menu to allow you to switch between the individual views.

The Display menu allows you to launch the most important NMS views.
The Test menu contains commands for starting and stopping the testing process.

The Filters menu allows you to select which errors you would like displayed.

The Options menu allows you to search for systems in the active window with the Find command, access
the Properties and reload the NMS database. (Testing must be stopped in order to reload the
database.) 

The Help menu shows program version and memory information.

The toolbar offers access to commonly used options and commands:

Figure 6.5  The NMS Desktop
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The first group of buttons controls window behavior (tile, cascade and scrolling). The second group regulates the
way in which system icons are displayed within the active window (large/small icons, details). The remaining but-
tons are explained below in Table 6.9 . (Not all toolbar buttons are always available.)

Table 6.9  NMS Desktop Toolbar Buttons 

Button Purpose

Shows all monitored systems in the NMS Full View window

Shows all important systems in the NMS VIP View window

Shows all systems returning errors in the NMS Error View window (The list can be filtered 
using the next four toolbar buttons.)

Shows systems returning critical errors in the NMS Error View window

Shows systems returning major errors in the NMS Error View window

Shows systems returning minor errors in the NMS Error View window

Shows systems returning warnings in the NMS Error View window

Shows all groups in the NMS Group View window. Double-clicking a group icon with the left 
mouse key opens the NMS Group Full View for this group. Double-clicking the right mouse 
key opens the NMS Group Error View.

Displays the map in the NMS Group View. This file can be specified using the Background 
Bitmap option on the General tab in the Properties dialog.

Begins the NMS testing process 
(all systems marked for cyclic testing are dialed sequentially)

Stops the NMS testing process

Shows systems that participate in Update Management in the NMS Update View window

Shows systems that were updated successfully in the NMS Update View window
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The NMS Desktop consists of a number of windows – or views – that show the network elements according to
importance, error or update status, group membership, etc. Each of these views is described in a separate subsec-
tion (see Chapter 6.3  to Chapter 6.8 ). In these windows, network elements are represented with icons that
provide information on the systems’ current status. These icons are described in Table 6.10 on page 38 .

Most common commands can be carried out in the NMS Desktop application with the aid of the context menu.
The commands available from this menu are described in Table 6.11 on page 40 . Individual systems are main-
tained using the NMS System Editor (cf. Chapter 6.2 on page 44 ).

Before you begin working with the NMS Desktop, use the program’s properties dialog to adjust the application
preferences to meet your needs (cf. Chapter 6.1 on page 41 ).

Table 6.10  System Icons on the NMS Desktop

Shows systems that could not be successfully updated in the NMS Update View window

Opens the Dynamic Groups window 
(shows the groups created using the Filter wizard)

Starts the SQL query tool known as the Filter wizard 
(used to define dynamic groups)

Launches the GATE Manager application and establishes a 
remote administration connection to the selected system

Causes NMSDoJob and NMSListen to reload the directory of routing files

Reloads the entire database

Shows program information such as version number and copyright

Icon  Description Error

Gray “X” in yellow square System does not participate in cyclical testing. (iLCR 
Boxes will be displayed with this icon only.)

Yellow “X” in red square System does not participate in cyclical testing. A sup-
port call has been received from this system. 

Table 6.9  NMS Desktop Toolbar Buttons (continued)

Button Purpose
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Depending upon the active view, one of three context menus is available
for editing database entries and maintaining tested systems. 

To access the menu shown to the right, right-click a system in the NMS
Full View, NMS VIP View or NMS Group Full View (The latter view
appears when a group is double-clicked with the left mouse key on the
NMS Group View map or when a group in the NMS Group View is
right-clicked and Open Group Full View is selected from the context
menu. For more information about the NMS Group View context
menu, see Chapter 6.5 on page 51 .

The commands shown in this context menu are explained in Table 6.11
on page 40 . 

OK in green circle Test passed without errors.

OK in yellow circle A single brief error occurred on this system. The system 
is operational again.

Exclamation mark

in red circle

A new error has occurred for the first time.

Exclamation mark
in yellow circle

Several errors have occurred in succession.

Black wrench

on warning sign

The maintenance flag is set on this 
system

Blue question mark

(on warning sign)

The system has been maintained and is now ready for 
testing. (Warning sign only visible in large icon)

Icon  Description Error
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Table 6.11  NMS Desktop Context Menu Commands 

Command Purpose

Set Maintenance Flag Select this option when an error has been detected and is being re-
paired. The system is excluded from the cyclic testing process. A con-
struction symbol with a wrench appears. This visual signal is intended 
to prevent several people from attempting to rectify the same error 
condition.

Remove Maintenance Flag Select this option when you have finished maintaining the system 
changes to the database entry. The system icon changes to a ques-
tion mark.

Test Cyclically Select this option to test this system in regular cycles. 

Don’t Test Cyclically Select this option to exclude the system from regular testing cycles. A 
yellow square with an “X” appears as the system’s icon.

Start Remote Use GATE Manager to establish a remote administration connection 
to this system.

Start Single Test Tests one or more selected systems by placing a data call to the sys-
tem’s dial-in number for NMS testing. Depending on the system’s sta-
tus, the call is either disconnected (if the system is operational), 
accepted (if an error has occurred) or not answered (if the system is 
not responding).

Find… Opens a standard Find dialog, allowing you to search for system 
names in the active window.

Open System Editor Select this option to access the system editor, in which the system’s 
specific settings can be altered. This same dialog is also accessible by 
double-clicking the system’s icon or by pressing the <F12> or <En-
ter> keys.

Explore Data Path Select this option to open an Explorer window displaying the directo-
ry containing this system’s data

Explore Routing Path Select this option to open an Explorer window displaying the directo-
ry containing this system’s routing path

View Error History Opens a window that displays a list of the last error messages re-
turned during NMS testing.

View GSM States Opens a window that displays a table with GSM statistical informa-
tion. Right-click in this window to export the data displayed.
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6 . 1  S E T T I N G  U P  T H E  N M S  D E S K T O P

Once you have started the program and familiarized yourself with the interface components described in the pre-
ceding section, you may need to adjust the program’s default settings to meet the specific requirements of your
network environment.

The NMS Desktop application can be password-protected if desired. Directly after installation, no password is as-
signed. If you would like to use a password to guard against unauthorized access to the program, press the New
Password button in the dialog that appears when the program is launched. Specify the desired password in the
space provided. You will be asked to confirm the new password by entering it a second time. To change the existing
password, first enter the old password before pressing the New Password button.

View IMSI List Opens a window that lists various information about the IMSIs on the 
system. Compares IMSIs retrieved with the job Get GSM States 
with the active initial IMSIs. Right-click in this window to import ini-
tial 
IMSIs or export the data listed.

View ASR Statistics Opens a window that lists ASR statistics for the last 15 to 46 days. To 
save database space, the statistics for the previous month are auto-
matically deleted on the 15th of each month. Right-click to export 
statistics or to display charts from the Statistic Tool.

View ASR Chart Opens a window that show a chart of ASR values.

View VoIP Statistics VoIP statistics are displayed for the selected system for the last 15 to 
46 days. To save database space, the statistics for the previous month 
are automatically deleted on the 15th of each month. Right-click to 
export statistics or to display charts from the Statistic Tool.

View VoIP ASR Chart Opens a window that show a chart of ASR values for the selected sys-
tem.

View Customer Data and Notes Opens a window that displays the Customer Data entered in the 
NMS System Editor.

Create New Database Entry Select this option to open the system editor dialog to enter settings 
for a new system.

Delete Database Entries Select this option to permanently remove the system(s) from the NMS 
database.

Export Data Data of one or more systems can be saved as Excel or txt files.

Table 6.11  NMS Desktop Context Menu Commands (continued)

Command Purpose
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The program settings can be adjusted from the Properties dialog, available by selecting the corresponding com-
mand from the Options menu. The Properties dialog can also be password-protected as described above for the
program itself. Separate passwords may be assigned for the NMS Desktop and the properties. 

Table 6.12  NMS Desktop Properties 

Option Purpose

General Tab

Outside line access Shows the outside line access prefix configured for this computer (to alter this set-
ting, use the NMS Configuration tool described in Chapter 4.2 )

Own number Shows the telephone number assigned to this NMS computer (to alter this setting, 
use the NMS Configuration tool) – this number must be identical with the 
RemoteOrigination entry in the network elements’ configuration files (i.e. 
0303992800).

Group The group to which the workstation belongs is displayed here. To change group 
assignments, use the NMS Configuration module.

Acoustic alarm 
(VIP View)

If this option is active, a warning tone is played when a VIP system returns an error 
message. 
(PC loudspeaker required).

Background bitmap Select a bitmap file for use as a background image in the NMS Group View. 

Check numbers on edit Forces the query for remote and test numbers after editing a system.

Show systems which are 
OK in error views

Includes systems that are running properly in the Error View displays. If this option 
is not active, systems are removed from error view as soon as they pass cyclic test-
ing without errors.

Colored Error Views Click here to display color-coded errors in the NMS Error View. This option requires 
a display setting of more than 256 colors.

Groups Tab

Group name Select the group name from the list provided, or enter a new group name and 
press the Create new group button below.

Update management When this option is marked, members of this group are enrolled in the update 
management process and receive updates and other current information when 
they connect to NMS.

Accept call if system is un-
known

This option determines whether or not NMS should answer calls from systems that 
are not in the database.

Automatic registration to 
update management

When this option is marked, newly installed systems will be enrolled in the update 
management process and automatically receive updates and other current infor-
mation when they connect to NMS.
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Automatic configuration of 
new systems

Automatic configuration through self-provisioning occurs on systems that auto-
matically log on with NMS Listen when the selected group is defined as Standard 
group for new systems in the TELES.NMS configuration. The provisioning data 
must appear in the NMS database inputconfig and the CFGs in the files 
pabx.cfg, route.cfg and ip.cfg in one of the following directories:
\\nms_data\Systemtypes\SystemTypeString\
Provisioning\
or:
\\nms_data\Systemtypes\SystemTypeString\Systems\
System-Name\Provisioning\

Send time from update 
management

If the ISDN line does not provide the time, mark this option to send the time from 
the NMS workstation to boxes and PC-based LCR systems during update manage-
ment.
The time sent can be the original system time or the system time with an offset. 
The offset can be defined for each group in the NMS_TimeOffset.ini file on 
the NMS server (\\nms_data\NMSFiles\).

Send default table First-generation systems only. Mark this option to automatically transfer a default 
configuration table to network elements that belong to the group. These tables 
are stored in the DefaultTable subdirectory of the Routing folder for each 
system type.

Send routing table Activate this option send new routing tables to systems in this group.

Get statistics First-generation systems only. Activate this option to retrieve statistical data from 
the network elements and insert them into the corresponding database.

Always accept call This command leads TELES.NMS to answer all incoming calls from systems in this 
group, even if no new table information is available for updating.

Fault management When this option is marked, members of this group participate in the fault man-
agement process.

Number of retries Specify how often NMS should redial systems that do not respond to testing.

Change group name Use this button to alter the name of the group. Select the desired group from the 
list above, edit the label and press this button to apply the changes.
TIP: When changing default group names, use names containing the 

group ID to ensure that group name and ID are easily associated.

Create new group Enter a new name in the field above and press this button to create a new group 
with this name.

TIP: When creating new groups, use names containing the group ID to 
ensure that group name and ID are easily associated.

Delete group Use this button to delete the group selected in the list above.

Table 6.12  NMS Desktop Properties (continued)

Option Purpose
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6 . 2  T H E  N M S  S Y S T E M  E D I T O R

The NMS System Editor is used to configure the test behavior and error handling of each network element. The
dialog appears in several different situations:

when new systems are included in the database using the Create new database entry command from
the context menu,

when an existing system is double-clicked in one of the NMS Desktop view windows,
when the Open system editor command is selected from the context menu,

or when <Ctrl> + <E> is pressed while a system is selected.

Day/Night Mode Tab

Switch to day mode Enter the time (in 24-hour format) at which daytime test mode should be activat-
ed.

Switch to night mode Enter the time (in 24-hour format) at which night mode should be activated. 
(There must be at least one hour between day mode and night mode starts.) 

Table 6.12  NMS Desktop Properties (continued)

Option Purpose
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With the aid of this dialog, the
testing preferences for each
individual system can be ad-
justed as needed. This is espe-
cially useful when settings for
particular systems must differ
from the settings for the group
to which the system belongs.
The dialog is shown in Figure
6.6 . The meaning of each
of the available options is ex-
plained in Table 6.13 on
page 46 .

Figure 6.6  NMS System Editor Dialog (System and Monitoring Options Tabs)
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The following table describes each of the options contained in the NMS System Editor dialog.

Table 6.13  NMS System Editor Dialog 

Option Purpose

System Tab

Name The system name entered here can be freely chosen, though it will also serve 
as the name for the system’s working folder. Thus, the name should not con-
tain spaces or special characters.

Group By selecting a group from the list, you determine which group the system 
should be assigned to.

Type This field displays the system type. When manually creating new systems, 
you can select the system type from the list provided.

Serial number The box system’s serial number is displayed here. (The serial number can only 
be entered manually when creating a new database entry). For second-gen-
erations, this is the TAG number. The FTP username is teles. The password 
it tcs-ag.

Version number The system’s software version number is displayed here.

VIP If the system is of special importance, mark this option.

Fault management Activating this option allows the system to participate in NMS testing rou-
tines

New configuration type (routing) Mark this option if routing information for this system is stored in the 
PermanentFile (route.cfg) rather than in the PABX.CFG.

Update management When this option is active, the system can retrieve routing updates when 
connected to a TELES.NMS computer.

Server message Information supplied by the server is shown in this space (for example, if an-
other user is currently accessing the data record, in which case no changes 
can be made in the entire System Editor dialog).

Customer Data Tab

The information stored in the customer data fields has no influence on the testing process. The spaces allow the 
entry of customer-specific information such as who to contact when questions regarding a particular system 
arise. The fields may also be left empty. Lines may be longer than the visible space, and can be scrolled using the 
cursor.

Server message Information supplied by the server is shown in this space. (This field appears 
on all three tabs.)
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Monitoring Options Tab

Test number Telephone number to be dialed for NMS testing. If testing over IP, enter the 
IP address using the following syntax: IP:<ip address>.

Remote access 
number

Number to be dialed for remote administration access to this system. If test-
ing over IP, enter the IP address using the following syntax: IP:<ip 
address>.

Remote access 
password

Password for remote administration access to this system.

Update base number Enter the telephone number this system should send as calling line identifi-

cation when it dials in to TELES.NMS to check for updates. If the database 
entry is created before the system dials in to NMS for the first time, this entry 
allows the incoming call to be associated with the proper database entry (i.e. 
0303992800), and is used to determine which routing tables are to be 
transferred.

Use FTP Check here to allow FTP file transfer. Enter an FTP User and FTP Pass-
word. The default settings configured on iGATEs are ip and ip, respective-
ly.

SIP Port Enter port 5060 to send SIP Invite messages to systems that are to set up a 
remote connection TELES.NMS.

Test cyclically This option determines whether or not this system should participate in reg-
ular test intervals.

At night During the night, NMS monitors all systems in the database for which this 
option is active. The time of day at which NMS switches from daytime to 
night mode can be specified using the Day/Night Mode tab in the Prop-
erties dialog accessible from the Options menu. The modes are factory-set 
to switch at 8 a.m. and 8 p.m.

Test priority This option determines the frequency with which the system is to be tested. 
Smaller numbers indicate shorter intervals between tests. Larger numbers 
signify longer intervals.
Examples: 0 and 1 – the system is tested every cycle

2 – the system is tested every second cycle

3 – the system is tested every third cycle

Alarm If this option is marked, an automated call is placed to the Operator e-mail 
address specified for this group on the NE Events tab of the NMS Event-
Manager dialog when errors occur on this system.

Table 6.13  NMS System Editor Dialog (continued)

Option Purpose
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6 . 3  E R R O R  V I E W

All systems that return error messages during testing are listed in a separate window. Filtering mechanisms allow
the inclusion or exclusion of specific error types. When the NMS Error View window is active, the Filter menu
options and the toolbar buttons for each filter are made available. The active filter types are marked in the Filter
menu with a “check”. Critical, major or minor errors can be displayed along with warnings.

The information displayed in this window includes system name, date and time of last contact, group, error cate-
gory, the status message returned during last contact, the date and time the last maintenance sessions began and
ended and the system type.

Activation time Date and time at which testing of this system began (if active) or the time at 
which testing should be resumed (if deactivated).

Server message Information supplied by the server is shown in this space (for example, if an-
other user is currently accessing the data record, in which case no changes 
can be made in the entire System Editor dialog).

GSM Settings Tab

GSM Settings shows a tree listing the system’s controllers and their respective SIM cards. You can enter new 

controllers and SIMs here. If the  icon appears when a new controller is listed, the controller has no SIM and 
the entry will be automatically deleted.

Delete All Deletes the entire tree

Import (Gateway Data) Imports IMSIs from the database of the job Get GSM Status.

Add controller Appears when you right-click in the window. A dialog box from which you 
can enter new controllers appears when you select this option.

Add SIM Appears when you right-click in the window. A dialog box from which you 
can enter new SIMs appears when you select this option. After you enter the 
SIM and click OK, a new dialog box appears. You can enter the new SIM’s 
IMSI, a number, PIN and/or user data in the appropriate text boxes. All infor-
mation entered here will then appear in the SIM’s listing in the tree.

Delete Appears when you right-click in the window or one of the entries in the tree. 
Selecting this option from the window itself will delete all entries. If you se-
lect this option by right-clicking an individual entry, only that entry will be 
deleted.

Edit Settings Appears when you right-click a SIM entry. A new dialog box will then appear. 
You can edit the SIM’s IMSI, number, PIN and/or user data in the appropriate 
text boxes. All changes will then appear in the SIM’s listing in the tree. 

Table 6.13  NMS System Editor Dialog (continued)

Option Purpose
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In order for systems to appear in the Error Views, they must be configured for fault management by marking the
corresponding option in the system editor dialog. 

Table 6.14  NMS Error View Filters for PC-based Systems

Filter Button Description Error Description

Critical errors Yellow lightning bolt

on violet background

Connection error related to Layer 1/2 error

New configuration or extern file 
activated

Errors occurred while activating 
configuration or extern file

Major errors Yellow lightning bolt

on red background

Message memory > 75% full

Minor errors Yellow lightning bolt on the 
checkered yellow-
brown background

Layer 1 error 

Layer 2 error 

Layer 1/2 reoperational
Remote administration access

Remote administration: invalid 
password 

Remote administration: invalid 
outgoing number 
Alternative routing threshold 
exceeded

Warnings Red lightning bolt on 
yellow background

System (re)started
System restarted via remote 
administration
LCR software started
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The categories for port errors of iLCR PC systems can be defined in the 
NMSTools.ini file (in \\nms.data\NMSFiles\), where 0
means no error, 1 means critical error, 2 means major error, 3 means
minor error and 4 means warning.

When a system is right-clicked in the NMS Error View or NMS Group
Error View, the context menu shown is adjusted to reflect the options
available in this particular setting.

(The NMS Group Error View appears when a group is double-clicked
with the right mouse key on the NMS Group View map.)

Several of the options described in Table 6.11 on page 40  are also
available in this context.

6 . 4  F U L L  V I E W

The NMS Full View window shows all tested systems in tabular form or as icons. The following table explains each
of the column titles used in the detailed list.

Table 6.15  Additional NMS Desktop Context Menu Commands (Error View)

Command Purpose

Remove System from Error View Select this option to remove the system from the error list after the 
error condition has been resolved and the system is operating prop-
erly. (Systems that do not participate in cyclic testing will be removed 
immediately.)

Export Data Creates a text or Excel file with the data shown in the window for the 
selected system(s). 
Specify the desired file name, format and location in the resulting di-
alog.

Table 6.16  NMS Full View Window Columns 

Column Title Column Content

System Name of tested system

Serial Number Serial number of system

Base Number Base number of system
50

vGATE 14.0. Revised: 21 July 2008.



T H E  N M S  D E S K T O P

C H A P T E R  6
6 . 5  G R O U P  V I E W

The NMS Group View window shows all defined groups as icons. You may select a bitmap image for display in this
window by selecting a file from the Background bitmap list on the General tab of the NMS Desktop properties.
The files included with TELES.NMS are maps, which allow you to place the icon representing each group, e.g. ac-
cording to its geographical location. You may use your own images as backgrounds by saving the desired files to
your NMS installation path and selecting them from the Background bitmap list. The background image can be
turned on and off using the corresponding button in the NMS Desktop toolbar.

This window is especially useful when reassigning systems to groups, as the selected systems can simply be
dropped onto the desired group icon to assign them to the group.

The context menu at the right can be accessed by right-clicking any one of the de-
fined groups in the NMS Group View window.

Select Open Group Full View to access the Group Full View menu (this view also
appears when you double-click any group listed). Open Group Error View calls
up the Group Error View window. To initiate testing for any group, select Start Group Test.

System Type Type of system

Date Date of last contact

Time Time of last contact

Group NMS testing group to which the system is assigned

VIP Systems that have been assigned VIP status are marked with an “X”

Error Category Lists the type of error that last occurred on this system

Status Message Displays the status message delivered during the last contact with 
this system

Maintenance Begun Shows the date and time the last maintenance session began

Maintenance End Shows the date and time the last maintenance session ended

Table 6.16  NMS Full View Window Columns (continued)

Column Title Column Content
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6 . 6  U P D A T E  V I E W

All systems that participate in the update process are also listed in a separate window. This window contains in-
formation including base number, system type, the dates and times of initialization, last contact and last update.
The status message from the last update and the flags are also shown for each system.

Green icons represent systems that have been successfully updated.

Red icons symbolize systems that couldn’t be successfully updated.

Table 6.17  NMS Update View Window Columns

Column Title Column Content

System Name of tested system

Serial Number Serial number of system

Base Number The update base number is displayed here as specified on the Mon-
itoring Options tab of the NMS System Editor

System Type Type of system

Initialization Date and time the system first contacted NMS with a polling or sup-
port call

Last Contact Date of last contact

Last Update Date of last update

Update Status Displays the status message delivered during the last contact with 
this system

Update RT. Shows whether the Update table flag is set for this system or group
(If the flag is set, an “X” appears in this column)

A.A.C. Shows whether the Always accept call flag is set for this system or 
group
(If the flag is set, an “X” appears in this column)

Upd. Conf. Shows whether the configuration update flags are set for this system.

If the Update configuration from files flag is set, an “F” appears 
in this column. When the Update remote access numbers flag is 
set, an “R” appears. 
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The context menu offers easy access to commands commonly required in
this setting. Several of the options described in Table 6.11 on page 40
are also available in this context. The options specific to the update pro-
cess are described in the table below.

Table 6.18  Additional NMS Desktop Context Menu Commands (Update View)

Command Purpose

Change Flags... Opens a dialog with four flag options that can be set to alter the be-
havior of the selected system(s) during the update process (cf. Table 
6.19 on page 55 ).

Change Files... Opens a dialog from which you can retrieve and process files from a 
PC-based system (see Chapter 6.9 on page 56  for the correct syn-
tax).

Update Firmware After you set this flag, use the drop-down menu to select a version to 
be updated. When this flag is set, an F appears in the column Upd. 
Conf. The update will occur the next time the system connects with 
NMS Listen. Save firmware files here:
\\nms_data\Systemtypes\SystemTypeString\Firmware\

Start Telnet Sets up a telnet connection to the selected system.

Initiate Callback A SIP Invite message is sent to the selected system that causes the 
system to set up a remote connection to TELES.NMS. TELES.NMS Lis-
ten then performs defined jobs such as provisioning or firmware up-
dates.

Explore Data Path Opens an Explorer window displaying the directory containing this 
system’s data.
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The Change Flags dialog shown in Figure 6.7  appears with all
of the options grayed, indicating that the flag status will be left “as
is”. Table 6.19 on page 55  describes the purpose of each flag.

You can select several systems in the Update View window and
change the settings for a particular flag, while leaving the others
“untouched”. To assign a flag to all selected systems, click the shad-
ed check box until a check mark without shading appears. To re-
move a flag for all selected systems, click the shaded check box until
it is clear. 

Example: To clear the always accept call flag and update
the remote administration numbers for all selected
systems, check the options as shown to the left.
(The update table flag remains unchanged for all
systems.)

Export Data Creates a text or Excel file with the data shown in the window for the 
selected system(s). 
Specify the desired file name, format and location in the resulting di-
alog.

Show Statistics 
(iLCR Box only)

Select this option to display a window with statistics information for 
iLCR Boxes. (Statistics information for other system types is available 
from the NMS Statistics application.) 

Delete CDRs in Database Deletes the CDRs stored in the database for one or more selected sys-
tems.

Delete Whole CDR Database Select this option to delete all CDRs for all systems stored in the da-
tabase.

Table 6.18  Additional NMS Desktop Context Menu Commands (Update View)

Command Purpose

Figure 6.7  Change Flags Dialog
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Table 6.19  NMS Update View Flags

6 . 7  V I P  V I E W

The NMS VIP View window shows all systems that have been marked as VIPs in the System Editor. This window
allows you to check the status of your most important systems from one central location, independent of system
type, area code or whatever other criteria you may have used to assign your systems to groups.

The information displayed in this window is the same as that shown in Error View. The context menu shown here
is also identical to that available from the Error View window.

Flag Purpose

Update table Select this option to update the routing table during the next connec-
tion. If this flag is not set, only status information will be exchanged 
during the next connection. No tables will be transferred.

Always accept call This command leads TELES.NMS to answer all incoming calls from 
this system, even if no new table information is available for updat-
ing. If this option is not active, NMS accepts calls from a given system 
only if new update information is waiting for the system.

Update configuration This command sends a new configuration table to the system upon 
connection.

Update configuration from input When this flag is set, the system automatically receives an updated 
configuration with data in the NMS input database upon connection. 
A C appears in the column Upd.Conf. The provisioning data must 
appear in the NMS database inputconfig and the default CFGs 
in the files pabx.cfg, route.cfg and ip.cfg in one of the fol-
lowing directories:
\\nms_data\Systemtypes\SystemTypeString\
Provisioning\
or:
\\nms_data\Systemtypes\SystemTypeString\Systems\
System-Name\Provisioning\

Update remote access 
numbers

When this flag is set, the remote administration access numbers 
specified in the configuration will be replaced upon connection with 
those specified in the System Editor. 

If the flag settings for a particular system differ from the default settings for the 
group (as defined on the Groups tab of the NMS Desktop properties dialog), the sys-
tem-specific setting takes priority. The flag Update remote access numbers is only 
considered if a routing table is to be tranferred.

ii
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6 . 8  D Y N A M I C  G R O U P S

Network elements may be organized into functional groups with the help of the NMS Filter tool and so-called “Dy-
namic Groups”. A new dynamic group can be created by selecting New Group from the context menu in the Dy-
namic Groups window or pressing the Filter Wizard button (marked with an “F”) on the toolbar.

The Filter dialog allows you to define an SQL query using the information stored in the database to filter out a group
of systems with common characteristics (such as all iLCR systems within the 040 area code). The resulting NMS
Filter View dialog shows all systems that meet the selected search criteria. The query can be saved as a dynamic
group using the corresponding option from the File menu. This type of group is referred to as “dynamic” because
the contents of the group are updated when new systems fulfill the search criteria. If in the example above, a new
iLCR is later installed within the 040 area code, it will be added to the dynamic group as soon as it is listed in the
NMS database. (Choose Refresh from the Edit menu in Filter View to update window contents.)

The dynamic groups may also be used to collect systems for assignment to the standard NMS groups. To do so,
define a query and then drag the displayed systems from the NMS Filter View window to either the desired group
icon or into the corresponding Group Full View window. If necessary, use the NMS Desktop Properties dialog to
rename existing groups or create new ones.

6 . 9  F I L E N A M E  P A R S I N G

When a network element calls (second-generation systems, <lowercase>iLCR and iGATE only), it can pick up any
number of files. You can set these file names in NMSDesktop using the following format:

The following options are possible:

Wildcards: “*”, “?”

Range of characters: “[...]”

Special fields: “%date...%”, “%time...%”

6 . 9 . 1  R A N G E  O F  C H A R A C T E R S

Only complete bracket pairs are recognized. Square brackets within the range of characters are not permitted. To
generate square brackets in the file name, you must type them twice (“[[“ or “]]”). Single brackets are ignored.
All upper case letters within the range of characters are converted to lower case. 

Wildcards (*, ?) within the range can only be used for groups. Other wildcards are ignored. A dash (-) signifies a
group (e.g. [0-9a-z]). The character before the dash must be of lesser value than that following the dash (ac-
cording to ASCII, upper case letters are converted to lower case letters in advance). Otherwise, the dash is ignored.
To use a dash as a character, you must type it twice (--).

6 . 9 . 2  S P E C I A L  F I E L D S

Enclose special fields in percent signs (%). If the text between the percent signs does not correspond to a special
field, the first percent sign is ignored, as are single percent signs. To use a percent sign as a character, type it in
twice (%%).

Example: %date...%
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%time...%
They differ only in their standard format (i.e. when they appear without a format specification or when an “s”
appears in the format).

Example:

Upper and lower case letters are recognized for format specification, but not for field identifiers (“date”,
“time”). 

Table 6.20  shows the various format specifications. Any characters not listed are accepted unchanged.

Table 6-1

%date% %date:s% %date:Ymd% %time:Ymd%

%time% %time:% %time:HM% %date:HM%

Table 6.20  Format Specification for NMSParseFilename.txt

Format Description

a Abbreviated name of a weekday

A Complete name of a weekday

b Abbreviated name of a month

B Complete name of a month

d Day of the month, in two digits (01-31)

d-<number> Date when the number of days entered in <number> (up to 999) is subtracted from d. 
Other date values (e.g. m and y) adjust automatically.

H Hour in 24-hour format (00-23)

I Hour in 12-hour format (01-12)

j Day of the year (001-366)

m Month (01-12)

M Minute (00-59)

p AM/PM indicator for 12-hour format

P Percent sign

s Standard format (for date: Ymd; for time: HM)

S Second (00-59)
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6 . 9 . 3  F O R M A T S  F O R  T H E  J O B S  C O P Y / P R O C E S S  S T A R T  E X T E R N A L  TO O L  
P A R A M E T E R

The following placeholders can also be entered in the Start and Start External test boxes. 

Essentially all formats and placeholders are possible that can be used under Filename. For example, the following
format will make sense: %date: m d% -> 11 25

Table 6.21  Additional Placeholders:

U Week of the year with Sunday as first day of the week (00-53)

w Day of the week with Sunday as first day (0-6)

W Week in the year with Monday as first day of the week (00-53)

y Year in two digits (00-99)

Y Year in four digits

# Leading zeros suppressed for following format specification (only for dHIjmMSUwWyY, 
otherwise ignored)

## Pound sign

! Escape, the next character will not be treated as a format specification

!# Same as ##

!! Exclamation point

Placeholder Definition

<fn> filename

<path> complete path for the file retrieved

<relpath_nmsdata> path relative to the NMS data directory

<relpath_systemtypes> path relative to system types

<relpath_systems> path relative to the systems directory

<path_system> system path

<path_downloads> download directory

<path_nmsdata> NMS data directory

<path_nmsfiles> NMSFiles directory

Table 6.20  Format Specification for NMSParseFilename.txt

Format Description
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<systemtype> system type (integer value)

<systemname> system name

<SHOW> console window is displayed (for debugging purposes)

Placeholder Definition
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7  S U P P L E M E N T A R Y  M O D U L E S

7 . 1  N M S  E V E N T V I E W E R 2

The NMS Event Viewer is an application module that displays NMS communication activities. The application tracks
the events that take place during communication between NMS and network elements, such as systems that can-
not be reached, or for which the password is incorrect. (The error history for individual tested systems is viewed
separately from the NMS Desktop).

The program assists in identifying problem systems that repeatedly return the same error conditions, and helps in
narrowing the range of possible causes.

The user interface consists of a single window in tabular form. Events are numbered in the Count column. The
Name column displays the name of the system on which the application is running. The Time column shows when
the event occurred. EventCat shows the type of event that occurred. The Program column displays the program
reporting the event, and Cat (category) indicates the urgency of the event. The Text column shows a more detailed
account of the event. The last three columns display the system’s RemoteNumber, TestNumber and LCR-ID.

You can alter column width according to standard Windows conventions and change the order of columns by drag-
ging the column title.

The File menu allows you to exit the TELES.NMS EventViewer2. With the Edit menu, you can use the Refresh
command to refresh the information on the screen, the Export Data command to export the window contents to
an Excel or text file, the Delete command to delete one or more selected entries, and the Delete Database com-
mand to delete all of the entries. You can also change the text and background color so that the different warning
categories are easily distinguishable. The Edit menu also appears when you right-click any entry in the TELES.NMS
EventViewer2. 

The View menu allows you to turn the Toolbar and Status bar on and off. The Help menu contains a single
option displaying basic program information.

The toolbar contains buttons to set filters, remove filters and call up basic program information. When you click
the filter icon, a dialog appears. Here you can set filters to limit the information displayed in the TELES.NMS
EventViewer2. The following table details the individual filter options in this dialog.

Figure 7.8  The NMS EventViewer2 Window
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Event log files are stored in the \Nms_data\Logging\Events directory. Files are automatically named with
a date and time stamp in dd_mm_yyyy_hh_mm format, such as 12_05_2004_00_28_01.log, and a running
number beginning with 0, in case several files are created per minute. 

7 . 2  N M S  E V E N T M A N A G E R

The NMS EventManager is a tool to help you define and optimize which events you would like to save in the da-
tabase. You can also save events in the WinNT-Event Log by opening the TELES.NMS Configuration (advanced)
program, clicking the Server tab, and checking the box next to Log events also in WinNT-Event Log.

Table 7.22  TELES.NMS EventViewer2 Filter Dialog

Option Purpose

Name TELES.NMS EventViewer2 will display only systems whose names match the entry in 
this box. Use an asterisk before and after your entry to include all system names con-
taining these characters. For example, if you enter *iLCR*, all systems with “iLCR” in 
their names will be displayed. Leave the box empty to display all names.

Remote Number If you enter a remote number in this box, only the systems with this remote number will 
be displayed. Use an asterisk before and after your entry to include all remote numbers 
containing the digits you have entered. Leave the box empty to display all remote num-
bers.

Test Number If you enter a test number in this box, only the systems with this test number will be 
displayed. Use an asterisk before and after your entry to include all test numbers con-
taining the digits you have entered. Leave the box empty to display all remote numbers.

Since Check the On box to enable the drop-down date menu. When you click the arrow next 
to the drop-down menu, a calendar appears. If you click a date in the calendar, all 
events that have occurred since that date will be displayed in the TELES.NMS 
EventViewer2. If the On box is not checked, all events will be displayed.

Events Only the checked events will appear.

Programs Only the events reported by the checked programs will appear.

Category Only the events with the checked warning categories will appear.

OK Sets the filters entered and closes the dialog.

Reset Removes all filters and closes the dialog. You can also reset the filters by clicking the 
Remove Filters button in the toolbar.

Cancel Cancels any changes made and closes the dialog.
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When you open the NMS EventManager, the window in Figure 7.9  appears. Click Event saving to select the
events you would like to save and Alarm sending to select the events for which you would like e-mail notification
to be sent. When you click Alarm sending, a box appears into which you can enter the e-mail address to which
notifications will be sent.

Both Event saving and Alarm
sending contain the following
tabs: Program Events, Data-
base Events, NE Events (net-
work element events) and Info
Events. Each tab contains a list of
NMS programs that report events.
Only the events reported by the
checked programs will be saved
and/or sent.

Each event tab also contains a list
of warning types: OK, critical,
major, minor, and warning.
Check the warning categories you
would like saved and/or sent. Only
the events registering the checked
level of urgency will be saved and/
or sent for the displayed tab.

At the bottom of the window, click
Apply to apply any changes, OK if
the settings are satisfactory and Cancel to cancel any changes you have made. The window will then close auto-
matically.

7 . 3  N M S  U S E R  M A N A G E R

The NMS User Manager is a stand-alone application module that enables you to define the specific rights of users
with access to TELES.NMS. 

In order to receive e-mails, the corresponding box must be checked in the system ed-
itor. Windows Messaging must be installed.ii

Figure 7.9  TELES.NMS EventManager
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The user interface consists of two windows, one for a quick overview of users and their rights and one to edit and
enter user’s rights. The first window is in tabular form and contains the following menus:

The File menu allows you to reload any changes that have been made at other workstations or by other
users since you last logged on to the NMS User Manager. The Reload button to the right of the table
performs the same task. You can also exit the NMS User Manager from this menu.

From the User menu, you can edit existing entries, enter new users and delete users you wish to remove
from the User Manager. You can also click the corresponding buttons to the right of the table to perform
any of these tasks.
The Help menu shows program version and memory information.

The window shown in Figure 7.10
appears when you select New or Ed-
it, or when you double-click any of
the users listed in the table. From this
window you can enter specific users
and their rights and edit the rights of
users already entered. NMSUser is set
as a default user with all rights.

This window contains boxes where
you can enter each specific user’s
username. Below this box the user’s
password can be entered. This pass-
word is valid for all applications to
which the corresponding user has ac-
cess. Below the password box you
can enter a description of the user’s
access.

Below these boxes is an explorer menu listing all NMS applications. Clicking the plus at the left of each application
causes a list of all possible access rights for that application to appear. In the checkbox next to each option you
can select or clear a particular user’s rights. You can also quickly assign or clear all NMS rights or all rights to a
specific application from the Rights menu or by clicking the appropriate buttons on the right side of the window.
Be sure and save any changes you have made before exiting. You can save from the Rights menu or by clicking
the Save button to the right.

7 . 4  N M S  J O B S

In addition to the automatic testing and monitoring features, TELES.NMS offers an application used to define rou-
tine tasks to simplify updates and recurring maintenance on network elements. While the program is installed on
each NMS computer, only one computer at a time can run the NMS Jobs application. The program requires a spe-
cial server application known as NMS JobServer, which must be running on the server. The NMS JobServer
coordinates jobs much like the NMS Server application. In order to carry out jobs, the NMS DoJob application
must be running on the server.

Figure 7.10  NMS User Manager
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7 . 4 . 1  M A I N  D I A L O G

The NMS Jobs interface is similar to the NMS Desktop.

The toolbar shown above offers easy access to view options such as Tiling, Cascading, Large Icons, Small Icons and
Detailed List view as well as filters, which allow you to specify which systems you would like displayed. The stan-
dard view windows and the Filter Wizard dialog can also be opened from the toolbar. A separate button provides
program information such as version number and copyright.

There are two standard views available. The Systems window displays network elements, and the Jobs window
shows defined tasks. The icons in the Systems window offer status information at a glance, and the icons shown
in the Jobs window indicate job status. These icons are explained in the following table.

Table 7.23  NMS Jobs Icons 

Icon  Description Meaning

Jobs Window

Yellow “J” on red background An error occurred while executing this job.

Lavender “J” on light green back-
ground

Job successfully completed.

Lavender “J” with yellow bar on 
green background

This job has been temporarily interrupted using the 
Stop running job command from the context menu.

Yellow “J” on gray background This job has been deactivated on the General tab of 
the job editor dialog.

 Yellow “C” with hourglass on 
brown background

New systems are currently being copied to this job. The 
job cannot be edited.

Blue “!” on lavender background This job is not correctly defined. System type or other 
information missing.

Light blue “W” on green back-
ground

This job is currently running or “working”.

Light blue “W” with hourglass on 
green background

This working job will be stopped when file transfer is 
completed. 

Systems Window

Light blue “S” on blue background New system.
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Right-clicking on a job displays a context menu with the
commands available for that particular job.

Table 7.24  NMS Jobs Context Menu Commands

Blue “S” on green background This icon appears in the Systems in Job window 
when the job was successfully executed on this system.

Yellow “S” on red background This icon appears in the Systems in Job window if 
the system was not able to carry out the job success-
fully.

Yellow “J” on blue background New job.

Command Purpose

Open System View 
of Selected Job

Opens the Systems in Job window displaying all of the systems to 
which this job has been assigned.

Edit Job Allows you to alter the settings for an existing job.

Find... Opens a standard Find dialog, allowing you to quickly locate jobs in 
the window.

Create New Job When you click an empty portion of the Jobs window, you can use 
this option to define a new job, specify recurrence options and the ac-
tions which should be carried out. 

Activate Job Marks this job as active, enabling the recurrence options set on the 
Timing tab. (Choosing this command has the same effect as select-
ing the Activate Job option on the General tab.)

Delete Job Deletes the selected job along with any system associations.

Icon  Description Meaning
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An additional context menu is available from the Systems in Job window,
offering the additional commands described in Table 7.25  below

7 . 4 . 2  C R E A T I N G  A  J O B

To create a new job, proceed as follows:

1. Open the Jobs window
2. Create a new job with the job editor by clicking an empty area of the window with the right mouse key

and selecting Create new job from the context menu.
3. A job editor dialog appears with various options for automating common tasks. These options are

described in detail in the following section. When you have made all of the necessary settings, press OK
to create the newly defined job.

Stop Running Job Interrupts the execution of a job that is currently active, allowing you 
to access the job settings. To deactivate the job indefinitely, open the 
job editor and deselect the Activate Job option on the General tab.

Reactivate Job Resumes execution of a job that was previously temporarily interrupt-
ed using the above option.

Start Running Job 
in 2 Minutes

Begins execution of the selected job after a two-minute delay by 
changing the Start Time set on the Timing tab (this command is 
not available for jobs that are set to recur cyclically).

Table 7.25  Additional NMS Jobs Context Menu Commands (Systems in Job window)

Command Purpose

Export Data Creates a text or Excel file with the data shown in the window for the 
selected system(s). 
Specify the desired file name, format and location in the resulting di-
alog.

Explore Data Path Opens an Explorer window displaying the directory containing this 
system’s data

Remove System(s) Removes the selected system(s) from the job
Note: not during running jobs)

Command Purpose
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4. From the Systems window, select the systems you would like to assign to the job, and drop their icons
onto the job icon in the Jobs window when the “+” sign appears.

(In order to execute created jobs, the NMS DoJob application must be running on the workstation.)

To view all jobs associated with a particular system, double click the network element’s icon in the Systems win-
dow to display the Jobs of System System name window.

7 . 4 . 3  J O B  E D I T O R  D I A L O G

The job editor dialog appears when you create a new job or edit an existing job. The dialog consists of four property
pages.

General Tab

Enter a Job Name in the field provided. An icon
with this name will appear in the Jobs window.
No spaces may be used in naming jobs. From the
list provided under System Type, select the type
of system for which this job will be used. This
choice affects the list of options available on the
Commands tab. The Maximum Channels
drop-down list allows you to select the number of
channels for the job. The Activate Job option is
not marked by default when a new job is defined.
The job will not be carried out until activated, re-
gardless of the recurrence options selected on the
Timing tab. This allows you to define new jobs
without running all of them right away. 

You can also right-click the newly defined job in the Jobs window and select Open sys-
tem view of selected job from the resulting context menu. A window titled Systems 
in Job Job name will open, displaying the systems that have been assigned to carry 
out this job. (You can also drop system icons into this window to assign network ele-
ments to the job.)

ii

Figure 7.11  NMS Job Editor
(General Tab)
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Timing Tab

NMS Jobs automatically executes jobs in preselected
intervals. The recurrence options for each job are de-
termined using this tab.

NMS Jobs supports four different recurrence pat-
terns for automated job execution:

1. No Cycle for non-recurring jobs.
2. To repeat the job on a weekly basis, choose the

Week Scheme by selecting On. Mark the days
of the week on which the job should be carried
out. 

3. To repeat the job on a monthly basis, choose the
Month Scheme by selecting On in the corre-
sponding group. Up to three recurrences per
month can be specified using the 1st day, 2nd
day and Last day of month options. Enter
numbers from 1 to 28 and mark the correspond-
ing option to run the job on the last day of the
month. 

4. To repeat the job in hourly intervals, turn the
Cycle Scheme On and select the number of
hours between recurrences. The job may not take longer than the time entered in the Max Job Dura-
tion field (default 60 minutes).

If the Weekend option is active in month or cycle scheme, the job will also be carried out if the chosen days fall
on weekends.

Use the Start Time and Stop Time fields to specify the time period during
which the job shall be executed. To do so, simply click in the field provided.
A popup window appears, displaying the current setting. These values can
be edited by clicking on the portion you would like to alter and using the key-
board to change the settings. The left and right arrow keys move the selec-
tion between the day, month, year and time values. The up and down arrow keys increase or decrease the value.

If you prefer to temporarily interrupt a running job (e.g. for maintenance purposes) 
use the Stop running job option from the context menu. If the job remains activated 
(Activate job option marked) and recurrence options have been selected on the Tim-
ing tab, the job will restart at the scheduled time.

ii

Figure 7.12  NMS Job Editor
(Timing Tab)
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If you prefer, you may also use a calendar view to set the date. This appears when the
pop-up list arrow is pressed.

Start Time also determines when recurring jobs begin. 

In the event that a job cannot be successfully completed on the first attempt, several op-
tions are available for repeating the job. You can specify how often you would like
TELES.NMS to attempt to reach each system using the Retry count per system field.
The Max Job Duration option determines how long NMS will continue to try to carry out this task. If the no limit
option is marked, the system will continue repeating until the job is completed successfully. The system will wait
at least 10 seconds between repetitions. This delay may be increased by altering the corresponding option in the
NMS JobServer’s Options menu (see Chapter 5.2 on page 35 ).

If the Don’t retry sequentially option is selected and some systems do not complete the job successfully, these
systems will be repeated before new systems are ordered to carry out the task. When a new job is defined, this
option is not active. NMS attempts to execute the job on each system before retrying systems on which execution
failed.

Commands Tab

One or more commands can be carried out
automatically with the current job. The avail-
able options will depend on the individual
systems. Mark the commands you would like
to carry out.

When the Update command is selected, the
Restart option is marked automatically and
the New Version Number field becomes
available. The version numbers that appear
here correspond to the subdirectories con-
tained within the Firmware folder for this
system type. Select the version number to be
upThe following table explains the purpose
of each command.

Figure 7.13  NMS Job Editor
(Commands Tab)
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Table 7.26  Commands Available from NMS Jobs 

Command Purpose

Get event log Downloads the event log from the remote system(s) and saves to the 
Errors subdirectory for each system in the shared data path on the 
NMS server (see Chapter 8.2 on page 83 ).

Get system info Updates the NMS database with data from system.

Start trace Starts Layer 2 & 3 trace on remote system(s).

Restart Reboots remote system(s).

Load charges Downloads charge information for outgoing calls placed via the re-
mote system and saves the data in the Charges subdirectory for 
each system in the shared data path on the NMS server (see 
Chapter 8.2 on page 83 ). 

Stop trace Stops tracing on remote system(s).

Test system Places a call to the remote system’s NMS testing number to verify op-
erational status. This command tests the system in the same fashion 
as the NMS Desktop, but allows you to use several B channels for 
testing (see Chapter 3.4.1 on page 17  for more information on 
this concept).

Backup CFG/routing files Downloads the current configuration and routing files from remote 
system(s) and saves them to the corresponding Backup directory 
(see Chapter 8.2 on page 83 ).

Load trace Downloads trace data from remote system(s).

Change holidays Replaces the Holiday entries in the system’s configuration with in-
formation in the holiday.cfg file from the Routing directory 
for each system type (see Chapter 8.1 on page 82 ).

Send routing tables Sends the routing tables saved in the Routing subdirectory in the 
shared data path on the NMS server. If testing via IP, you must enter 
the Update Base number shown on the Monitoring Options 
sheet of the NMS System Editor. This number is the same as the 
area code. For second-generation systems, only the TAG number is al-
lowed as the name of the routing directory. (see Chapter 8.1 on 
page 82 ).
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Set time Sets the network element’s system time to agree with the current 
time on the local workstation. The time sent can be the original sys-
tem time or the system time with an offset. The offset can be defined 
for each group in the NMS_TimeOffset.ini file on the NMS 
server (\\nms_data\NMSFiles\).

Get Mobile status Retrieves and evaluates mobile status data. Compares IMSIs and 
records errors in case of irregularities. All systems with blocked ports 
will appear in light blue in all NMSDesktop views except Update and 
Group when this command is marked.

Send routing/perm. file Sends the complete route.cfg file to the network elements, as 
well as the extern files. If testing via IP, you must enter the Update 
Base number shown on the Monitoring Options sheet of the 
NMS System Editor. This number is the same as the area code. For 
second-generation systems, only the TAG number is allowed as the 
name of the routing directory.

Get statistic Gets statistical data from the network elements and inserts them into 
the corresponding database.

Get VoIP Statistics NMS Jobs queries retrieves VoIP data. Statistics appear in NMSDesk-
top views as they appear for ASR values.

Provisioning Activate this checkbox to perform provisioning with NMS Jobs 
(cf. Chapter 3.4.6 on page 19 ).

Send MPC Sends bootrom.bin file to iLCR 4BRI-IP Box for firmware update.

Initiate Callback A SIP Invite is sent to all network elements through port 5060. The 
systems then set up a remote connection to TELES.NMS. When Ini-
tiate Callback is defined as job, no other jobs can be defined. NMS 
Listen then performs defined jobs, such Provisioning or Firmwareup-
date (cf. Chapter 7.6 on page 76 ).

Send TIB Sends tib.cfg to iLCR 4BRI-IP Box.

Get ASR Statistics Retrieves ASR data and sends an error message if either ASR 1 or ASR 
2 falls below the percentage entered. ASR type is recorded in the er-
ror log. All systems with blocked ports will appear in light blue in all 
NMSDesktop views except Update and Group when this command 
is marked.

Table 7.26  Commands Available from NMS Jobs (continued)

Command Purpose
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Update Updates the system software for the remote system. When this com-
mand is selected, the Restart option is marked automatically and 
the New Version Number list is made available. Select the version 
number to be uploaded. The version numbers that appear here cor-
respond to the subdirectories contained within the Firmware fold-
er for this system type in the shared data path on the NMS server (see 
Chapter 8.2 on page 83 ).

Send CFG files Uploads the configuration files stored in the Config subdirectory 
for each system in the shared data path on the server (see 
Chapter 8.1 on page 82 ).

Alarm (group box) Here you can limit alarm messages. When Only Mobile Ports is 
checked, an error message for mobile ports only will appear in the 
event viewer, depending on which options you select.

Activate configuration Activates the configuration specified in the pop-up list. (Available for 
PC-based systems only!)

Table 7.26  Commands Available from NMS Jobs (continued)

Command Purpose
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Copy/Process Tab

A common TELES.NMS maintenance task
is the transfer of files to and from PC-
based systems. (Box-based systems have
no file system, and so no files can be
transferred to these units.)

To select files for transfer from the net-
work elements to NMS, press the Add
button shown in the From System to
NMS section of the tab and type the File-
name of the file you would like to down-
load from the remote system in the
appropriate text box of the editor that ap-
pears. If you enter a batch file in the Start
External box, the application(s) entered
will start automatically when the file is
copied. For details on how to format
batch processes, see Chapter 6.9 on
page 56 . For each file, you can deter-
mine whether or not you would like to
Delete source. The Remove button al-
lows you to delete previously selected
files from the transfer list. 

In order for files to be copied from the net-
work elements to NMS, they must be
present in the Uploads subdirectory in
the shared data path on the NMS server
(see Chapter 8.1 on page 82 ). The Add button opens a standard Windows browsing dialog with which you can
select files for transfer to the system. To select several files at once, use the <Ctrl> and <Shift> keys according to
the standard Windows conventions. Files selected for transfer are shown in the From NMS to System field. Dou-
ble-click an entry to call up a dialog that allows you to select a Destination for the file and enter a batch file to
Start Before Copy. For each file, you can determine whether or not you would like to Delete Source. When
copying from a network element to TELES.NMS, use the syntax described in Chapter 6.9 on page 56 . The Re-
move button allows you to delete previously selected files from the transfer list.

Figure 7.14  NMS Job Editor
(Copy Tab)
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Change/Get Files Tab

As of version 3.0, TELES.NMS can be used to ex-
change individual lines in network elements’ config-
uration files.

When a new job is defined, the Change/Get Files
tab is displayed as an empty table as shown at right.

To specify a new set of information to be exchanged,
right-click in the empty portion of the table and se-
lect New from the context menu.

The dialog changes to allow you to specify the infor-
mation you would like to replace. Specify the file
name in which the change is to be made (when
changing lines in box-based systems’ configuration
tables, enter table as the file name). Enter the new
command sequence in the space provided, and the
line it should replace (if applicable). Specify whether
the information added is a change to an existing line,
an addition or a deletion. Wildcards such as * and ?
may be used to substitute for character sequences
and single characters.

Example 1 To replace the
NtpServer=192.168.2.5 with
NtpServer=192.168.2.20 in the pabx.cfg,
enter the information as shown at right.

Example 2 To delete all MapOut entries from the configuration ta-
ble, enter the information as shown at right.

Click the OK button contained within the Change/Get Files tab when
you are finished defining the information you would like to exchange. The
dialog reverts to the table view, where your change now appears in the
list of lines to be altered. You can edit or delete any of these sequences later by selecting the corresponding com-
mand from the context menu.

7 . 5  N M S  D O J O B

The NMS DoJob application is responsible for managing job execution. The program’s interface consists of a set-
tings dialog that appears when the program is launched, a taskbar icon and context menu, and a status dialog that
displays information on active jobs.

Figure 7.15  NMS Job Editor
(Change/Get Files Tab)
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7 . 5 . 1  S E T T I N G S  D I A L O G

When the NMS DoJob application is launched, the settings dialog shown
at right appears, allowing you to alter the program’s default settings.

On first launch, the dialog remains on screen until confirmed. After the pro-
gram is first run, the window will only appear for 10 seconds. If the settings
are not changed during this delay, the program will start using the configu-
ration used during the last session

.

Table 7.27  NMS DoJob Settings 

Option Purpose

Write trace files When this option is selected, program activity is logged to files stored 
in the installation directory. Two files named DoJobnumber.trc 
and DoJobnumber.log are created for each B channel used by 
the application, where number represents the B channel.

Check serial number This option activates the serial number verification procedure, which 
requires that the system’s serial number agree with the number en-
tered in the database in order for jobs to be executed. If this option 
is not active and the application detects a serial number that deviates 
from the database entry, the information in the database is updated.

Allow update to former version Set this flag to update the system software to a previous version.

Use command line tool
for update

Selecting this option launches the external command line tool when 
updating the software on box-based systems.

Don’t reset box event log Leaves the event log unchanged when running jobs on box-based 
systems. (On PC-based systems, the event log is always saved as 
protocol.tmp and reset when jobs are executed.)

Use x B channels In the field provided (represented here with x), enter the number of 
B channels DoJob should use for job execution

Figure 7.16  NMS DoJob
Settings
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7 . 5 . 2  C O N T E X T  M E N U

The context menu offers access to the status dialog described below, provides com-
mands for saving trace and log files and allows you to rescan the routing directory
for new files (useful if you have added or removed files from the folder hierarchy
since the application was started). The About command displays program informa-
tion such as version number and copyright, and the Exit DoJob command quits the
program.

Status dialog

The status window offers an overview of the activities on each B channel assigned
to the DoJob application. The window appears in tabular form, listing for each chan-
nel the current job, the number dialed, connection status, command being executed and an error message, if any.
The Terminate Line(s) button allows you to deactivate a selected B channel. Channels deactivated can be reac-
tivated using the Start Line(s) button. Click Abort Job(s) to cancel the execution of the current job on the se-
lected channel. This frees the channel for the next pending job.

7 . 6  N M S  L I S T E N

The NMS Listen application serves to accept incoming calls from network elements and provide these with current
routing tables or complete configuration files as necessary. The application also stores cached information on the
contents of the Nms_data directory structure to speed up the transfer of new routing tables and thus keep con-
nection time to a minimum.

TELES infrastructure systems dial in to the NMS Listen application at a specified interval to signal their operational
status (second-generation systems call TELES.NMS using a TCP channel). This so-called polling call shows
TELES.NMS that the system is still up and running, and offers the opportunity for further actions such as routing
table updates, etc. Systems can also be configured to contact TELES.NMS at a separate support number when er-
rors occur. Listen can also take calls with a video or speech service indicator.

When working on an NMS PRI workstation, assign a large number of B channels (such 
as 20) to the NMS DoJob application and deactivate any channels you do not currently 
need by selecting them and pressing the Terminate Line button in the NMS DoJob Sta-
tus window. This allows you to increase the number of channels later (using the Start 
Line button, without having to stop all running jobs and restart the DoJob program.

NMSDoJob includes internal redial per call attempt. This can be set in 
NMSDevice.ini in d:\Winnt\System32\ISDN\TELES on the workstation running 
NMSDoJob (CONNECT_RETRYS=). The default setting is three redial attempts.
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When the application is launched, the Listen Settings dialog
appears, prompting you to specify both of these numbers and
the number of B channels you would like to reserve for the pro-
gram.

A taskbar icon represents the application’s connection status.
A green icon signalizes “ready” status. The application is pre-
pared to accept incoming calls. A yellow icon represents con-
nection establishment negotiations on the D channel, and a
red icon indicates an active connection. A context menu ap-
pears when the taskbar icon is clicked using the right mouse
key. This menu offers seven options, allowing you to open the
application’s dialog window, to reload routing files, to show
routing files, to show listen numbers, to show standard group
properties, to show call statistic and to exit the application.

If telephony or teletex are activated in the Special Service In-
dicator, NMSListen will take these calls in addition to data
calls.

The program’s main window displays offers Channel and Logbook views. The Channel view shows information
on each reserved B channel in tabular form. This includes the channel status, the calling party number transmitted
by the network element, the system name, type and serial number, the software version of the connected system
and the action currently being performed on this system.

The Logbook view will be displayed after the Listen Settings dialog is confirmed. It shows all incoming calls
from the network elements. Icons colored red show where problems have occurred. 

If an incoming call identifies the calling 
system with both CLI and serial number, 
the Always search for base number option 
determines which is used to find the sys-
tem in the NMS database. This option can 
only be set via the registry.

Figure 7.17  Listen Numbers
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If the Write log file option is set in the Listen Numbers dialog, log files will be written to disk in the
\\nms_data\Logging\Listen directory of the workstation every midnight.

The Standard Group Properties command on the View menu opens
a dialog that displays the current settings for the standard group for
new systems. This group is selected on the General tab of the NMS
Configuration dialog (see Table 4.6 on page 25 ). The individual op-
tions for this group are configured on the Groups tab of the NMS Desk-
top Properties dialog (see Table 6.12 on page 42 ). 

Figure 7.18  NMS Listen Logbook

Figure 7.19  NMS Listen Standard
Group Properties
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The Routing Tables command on the View menu
opens a dialog that displays the current routing ta-
bles assigned to each system type and area code. If
you have changed the contents of the Routing
subdirectories this has to be reloaded. 
This can be done via the context menu or via the
File command of the NMS Listen window.

7 . 6 . 1  U P D A T E  M A N A G E M E N T  A N D  I N C O M I N G  C A L L S

The most important condition for accepting incoming calls is whether the system is in update management or not.
For known systems, update management must be set for the system (in group or through the system editor). For
unknown systems, update management must be set for the standard group. The call will be rejected if this is not
the case.
Support calls will be handled based on the device:

1BRI, 2BRI, 6BRI, 4BRI-IP, PRI boxes 

ilCR-PC

iGATE
iGATE-C

VoIPGATE

Second-generation iGATE
Second-generation VoIPGATE

VoIPBOX BRI

1BRI, 2BRI, 6BRI, and PRI Boxes

These systems communicate what they need. Lists evaluate this information and react accordingly. If the box re-
quests a table, the type of table sent, default table or routing table, depends on the flag set, as with the iLCR Boxes.

To be able to view the routing table assignments, a routing table has to be placed 
inside each area directory, which are one directory level below the Routing directory.

Figure 7.20  NMS Listen Routing Table Assignments 
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If the system wants to provide charge data or the eventlog, this is only possible if the system is already known or,
in the case of unknown systems, the "automatic registration to update management" flag is set in the standard
group. 

In the case of the GetStatistic flag, handling occurs as with the iLCR Boxes.

ilCR PC, iGATE,iGATE-C and VoIPGATE

Systems in the database receive a routing table if the "update table" flag has been set for the system. If this flag
has not been set for the system, but the "send default table" flag has been set for the group, the system receives
a default table. 

If the system is not in the database, the flags in the standard group determine whether a table is sent, and if, then
which one. Furthermore, the eventlog (protocol log) is picked up with each support call.

Polling Calls

For a polling call of a system in the database, whether a call is accepted is decided on the basis of the flags in the
Group Properties (the same for all system types):

Automatic registration to update management
Send default table (first-generation box-based systems only)

Send routing table (except when the "update system" flag has been deactivated for an individual system) 

Get statistic (first-generation box-based systems only)
Always accept call (except when the "always accept call" flag has been deactivated for an individual
system) 
Send time from update management

If the call should come in without CLI, the "accept unknown system =yes or no" flag in the standard group (usually
NMC) determines whether the call is accepted.

If the calling system is not in the database, the call will only be accepted if the "accept call if system is unknown"
flag or the "automatic registration to update management" flag or the "send default table" flag has been set in
the standard group. In the case of a polling call, only those actions the user specifies with the flags in the Group-
Properties are carried out by the NMS Listen.

The following applies for (accepted) polling and support calls: ChangeRemoteNumber and ConfigFromFile only
works with 1BRI, 2BRI, 6BRI, 4BRI-IP and PRI boxes. GetStatistic also works with an iLCR Box.
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8  S Y S T E M  D A T A  D I R E C T O R I E S
The Nms_Data directory on the server must be shared to allow other NMS workstations to access the common
data. This directory is contained within the installation directory (typically D:\TELESNMS). Leave the folder name
unchanged in the Share Name field. Assign full access rights and confirm the settings with OK. The diagram be-
low shows a typical folder hierarchy created by TELES.NMS.

The directory structure on your NMS computers will be
similar to the sample tree shown here. The contents of
these directories are described in more detail in the follow-
ing sections.

The hierarchical nature of this data structure allows for the
distinction of generic information pertaining to systems of
a certain type (such as default configurations, routing files
and firmware) and system-specific data such as backups,
charges and error logs.

The subdirectories under Systems correspond to the
names of each of your systems as entered in the common
database. Each of these system-specific directories may
contain subdirectories with data transferred from the sys-
tem or intended for transfer to the system.
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8 . 1  G E N E R I C  I N F O R M A T I O N  F O R  S Y S T E M S  O F  S A M E  TY P E

Config

Configuration information may be stored generically for all systems of a particular type, or separately for each sys-
tem requiring special settings. When the Send CFG-files command is carried out using the NMS Jobs module,
configuration files stored in the corresponding directory are transferred. If there is no specific Config directory
for a system, the files in the generic Config directory for this system type are transferred instead.

Firmware 

Each system type has its own Firmware directory, containing subdirectories with different versions of the soft-
ware. These subdirectories have to be created manually and named after the software version. For PC-based sys-
tems, they should contain only the uncompressed driver files (not the compressed self-extracting archive in .exe
format!). For box-based systems, both .bin and .upd files should be located here. When the Update command
is marked on the Commands tab of the NMS Jobs module, the names of these subdirectories appear in the New
Version Number list. When the Update job is executed, the contents of the selected version subdirectory are
transferred to the system. 

Systems

This directory contains system-specific data. The names of the subdirectories in the Systems directory correspond
to the names of the systems in the database.

Uploads

This directory is used to store miscellaneous files for transfer to PC-based systems. Files in this directory can be
automatically transferred using the NMS Jobs module (see the section on the "Copy/Process Tab" on
page 73 ).

Routing 

Routing information is organized according to system type. Further distinctions are made using subdirectories. Sep-
arate subfolders may be used for number ranges requiring different routing instructions. Use subdirectories corre-
lating to the first digits of area codes in which your systems are located (or even whole numbers of certain systems).
Each area code folder may also contain further subdirectories corresponding to each software version used, and/
or group ID folders.

When the Send Routing Tables command is carried out using the NMS Jobs module, routing information is
picked up from the system and replaced with the information stored in the deepest Routing subdirectory on the
NMS Server. See the directory structure on page 5-83.

With the file NMSTools.ini you can determine that the appropriate routing files ex-
ist for all system types in the same routing directory (e.g. 
iLCR_2BRI_Box\Routing). The file can be found in the server directory 
D:\TELESNMS\NMS_DATA\NMSFILES.
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The lowest folder has the highest priority. When routing information is updated, TELES.NMS first looks for routing
files (or a version-specific subdirectory containing these) in the appropriate group ID folder. If this information is
not stored there, or no group ID directory is found, the software looks “up the tree” one level for an area code
folder. If no routing information is stored there either, the “No routing table available” message will appear in the
NMS Desktop when a routing table update is attempted.

The folders may contain holiday.cfg files used to (re)define the Holiday entries in the system’s configura-
tion file.

For PC-based systems such as iLCRs and iGATE systems, each of the Routing subdirectories must contain the
files used to define routing settings and specify other routing files. While older systems may store routing informa-
tion in the PABX.CFG alone, a route.cfg file must be present in this directory to allow NMS to automatically
update the routing entries in the system’s PABX.CFG file. Newer systems use the route.cfg
PermanentFile and optional ExternFiles containing time-dependent routing information. All routing files
defined with ExternFile must also be contained within this directory in addition to the mandatory
route.cfg. 

For iLCR Boxes, each of the Routing subdirectories contains a route.cfg or a binary file in .hex format with
the complete configuration required for the proper operation of the box. 

For TELES.iLCR 1BRI, 2BRI and 6BRI Boxes, each of the Routing subdirectories contains either a binary file in
.hex format with the complete configuration or a route.cfg file with routing information only. If a .hex file
is present, this will be used and the ASCII version ignored. 

8 . 2  S Y S T E M - S P E C I F I C  D A T A

Backup 

Each system may have its own Backup directory within the folder hierarchy. When the Backup CFG/Routing
files command is carried out using the NMS Jobs module, a new subdirectory is created, named with the current
date and time. A backup of all critical files is then copied to this directory. For PC-based systems, these include the
STARTPBX.BAT, PABX.CFG, route.cfg (if existent), all ExternFiles used for routing, any
NightFiles and tib.cfg (if existent). For box-based systems, the configuration table is backed up in hexidecimal
and ASCII formats.

For box based systems any comments contained in routing files will be removed. The 
route.cfg files stored in these folders should contain only routing entries (map-
pings) – no configuration commands should be present in these files as such com-
mands could conflict with the current configuration and make the system 
unreachable! 
(Use the NMS Jobs module to exchange individual configuration commands in the 
header portion of the configuration table. See the section on the "Change/Get Files 
Tab" on page 74  for more information on this procedure.)
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Charges

Each system may have its own Charges directory within the folder hierarchy. This directory contains all charge
information on calls placed by this particular system. For PC-based LCR systems, this directory may contain
charge.log files with automatically generated names such as CHA_060720041530_0.LOG. (The files are
automatically named beginning with CHA followed by a date and time stamp in ddmmyyyyhhmm format and a
running number beginning with 0, in case several files are created per minute.)

For TELES.iLCR 1BRI, 2BRI and 6BRI Boxes, this directory will contain a single file named
CHA_010120041255_0.log. This file is sent automatically to TELES.NMS and appended when new data
comes in. 

Config

Systems that require special settings which deviate from the standard configuration for network elements of this
type may have their own Config directory within the folder hierarchy. When the Send CFG files command is
carried out using the NMS Jobs module, configuration files stored in the corresponding directory are transferred.
If there is no specific Config directory for a system, the files in the generic Config directory for this system type
are transferred instead.

Downloads

Each PC-based system may have its own Downloads directory within the folder hierarchy. This directory is used
to store miscellaneous files downloaded from systems using the GATE Manager software or with the NMS Jobs
module (see the section on the "Copy/Process Tab" on page 73 ).

Errors

Each system may have its own Errors directory within the folder hierarchy. The directory contains event logs for
this particular system. For boxes and PC-based systems, this directory may contain protocol.log files with au-
tomatically generated names such as PRO_100920041845_0.LOG. (The files are automatically named begin-
ning with PRO followed by a date and time stamp in ddmmyyyyhhmm format and a running number beginning
with 0, in case several files are created per minute.)
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9  N M S  TE S T I N G ,  PO L L I N G  A N D  S U P P O R T  
P R O C E D U R E S

9 . 1  G E N E R A L  I N F O R M A T I O N  O N  TE S T I N G

TELES.NMS tests network elements in regular intervals by placing a data call to the system. If the system is opera-
tional, it responds with an alerting signal to tell TELES.NMS that it is still working properly. NMS then disconnects
the call. If an error has occurred, the system accepts the call, and NMS picks up the event log.

The test cycle frequency and the maximum duration of each individual test can be specified on the Server tab of
the NMS Configuration module. Specify a shorter test duration if a large number of systems is to be tested. If
only a few systems need to be tested, a longer test duration value may be entered to allow the software more time
for communication with each system. 

All systems are tested sequentially during the first test cycle. In the second cycle, systems are tested according to
the Test priority assigned in the NMS System Editor. This value determines how often the system is tested. 

When the automatic test routine is running, the systems excluded from testing are represented by yellow squares
containing an “X”. Only the systems for which the Test cyclically option is marked in the System Editor participate
in the test process.

9 . 2  S W I T C H I N G  B E T W E E N  D A Y T I M E  A N D  N I G H T  M O D E S  

In daytime mode, every network element in the database is tested if the Test all systems in daytime mode
option is marked on the Server tab of the NMS Configuration dialog. In night mode, NMS tests only network
elements for which the At night option is marked in the NMS System Editor. The times at which TELES.NMS
switches between daytime and night modes are specified (in 24-hour format) on the Day/Night Mode tab of the
NMS Desktop properties dialog.

9 . 3  A L A R M  F E A T U R E  ( A U T O M A T E D  C A L L )

For information on receiving e-mail alarm notification, please see Chapter 7.2 on page 61 .

9 . 4  B E G I N N I N G  T H E  TE S T  C Y C L E

The automatic test cycle can be initiated using the Start Testing  button in the taskbar or by selecting Start
from the Test menu. During the first test cycle, all systems are tested sequentially. In the second cycle, systems are
tested according to the Test priority assigned in the NMS System Editor. This value determines how often the
system is tested (see Table 6.13 on page 46 ). 
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9 . 5  M O N I T O R I N G  T H E  TE S T  P R O C E S S

System settings cannot be changed while the test cycle is running. Systems returning error messages appear with
red icons. Green icons represent operational systems. The NMS Error View window shows all systems that have
returned error messages for a quick overview of systems that may require attention. These systems are marked with
different icons depending on the type of error that has occurred (see Table 6.10 on page 38 ).

The test process can be interrupted at any time using the Stop Testing  button in the taskbar or be selecting
Stop from the Test menu.

9 . 6  P E R F O R M I N G  M A I N T E N A N C E  D U R I N G  T H E  TE S T  C Y C L E

While the test process is running, you can select any system and open the System Editor to change test behavior
or open a maintenance connection via remote access. 

Before you begin making changes to a system’s settings, be sure to choose the Set maintenance flag command
from the context menu to be certain that the system is not concurrently accessed by more than one person. In ear-
lier TELES.NMS versions, this flag was a visual signal only – the system was not completely locked and the cyclic
testing process was not interrupted. As of version 2.71, cyclic testing is stopped. When you have finished with
maintenance, be sure to choose the Remove maintenance flag command from the context menu. The system
will remain in the Error View and the icon will change to a question mark. Once the system passes testing, the icon
will change to the “OK” symbol and the system may be removed from the Error View with the Delete systems
from error view command from the context menu.

9 . 7  C Y C L I C  TE S T I N G  V I A  M O R E  T H A N  O N E  B  C H A N N E L

NMS Tester is a new module allowing cyclic testing via more than one B channel. The number of available chan-
nels and the reserved channels for the single test are displayed. The desired number of B channels to be reserved
for testing can be entered in the dialog box.

Figure 9.21  NMS Tester
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9 . 8  E V A L U A T I N G  TE S T  R E S U L T S

TELES infrastructure systems can distinguish three different error conditions during the testing process:

1. The system is operating properly. The incoming call from TELES.NMS reaches the system, which responds
with an alerting signal to tell TELES.NMS that it is still working properly. NMS then disconnects the call.

2. Errors have occurred in the system. The incoming call from TELES.NMS is accepted. Either the system was
rebooted, Layer 1 or 2 errors occurred on a port, or an attempt was made to access the system with an
invalid password. These irregularities are saved in the event log. This data is picked up and parsed for
errors during connections to TELES.NMS (see Table 6.14 on page 49 ). The detailed error information
contained in this file can then be used to correct the error conditions. 

3. The system does not respond to the incoming call from TELES.NMS. This may have one or more causes: 
– the system is not configured for testing, 

– the system is overloaded and cannot accept the call, or 

– the system is turned off or crashed.

9 . 9  TR O U B L E S H O O T I N G  E R R O R  C O N D I T I O N S

Error Condition 2:

1. Evaluate the protocol.log file. The system name appears in the log file and in the Error View win-
dow. Check the possible causes:
– System rebooted via remote administration either manually or as a result of iLCR HUB Board failure.

Check to see if the system is now operating properly again.

– An error occurred on a port. Check to see if the error persists. 

2. Check the system with a remote administration connection. If the error persists, reboot the system and
check again.

Error Condition 3:

1. Repeat the test. If no protocol.log file is transferred, the system is overloaded and cannot respond.
If the connection is established, evaluate the protocol.log file and continue as described above
under Error 2.

2. Establish a remote administration connection and check that the test number is properly configured. 
3. If the system does not respond to calls, it may require on-site service.
The information returned during testing depends upon the system type. (For box-based systems, for example,
TELES.NMS 14.0 only treats ErrorCode values greater than 0 as errors.) For information on the errors that may
occur for each system type, consult the corresponding chapters in the TELES Infrastructure Systems Manual.

9 . 1 0  R E M O T E  A D M I N I S T R A T I O N

TELES.NMS integrates the GATE Manager software for remote administration connections to monitored systems.
To make use of this option, use the System Editor to enter a remote administration password and number for each
system in the database.
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Select the desired system from one of the NMS view windows and right-click the system icon to access the context
menu. Choose the Start Remote option from the context menu to establish a remote administration connection
to the system.

9 . 1 0 . 1  I N C O M I N G  C A L L S  F R O M  N E T W O R K  E L E M E N T S

During the polling and support processes, network elements place data calls to TELES.NMS. The way these calls
are handled depends upon several factors including the number dialed (polling or support number), the flags set
for each system (or the group to which it belongs) and the system status at the time the call is placed.

NMS Desktop windows cannot be closed while remote administration is active.

ii
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Figure 9.22  below shows how TELES.NMS handles these incoming calls. Table 9.28  through Table 9.31
explain the decisions that are made during the process and the procedures that are carried out if the call is accept-
ed.

Incoming call
to NMS from

network element

To which number?Polling

Support

Accept call?
(Table 5-25) Yes

No

Accept call

Log last contact Update database
(Table 5-28)

Perform
operation

(Table 5-27)

DisconnectReject call

System
in database?
(Table 5-26)

No

Automatic
registration

active?

No

Add new
system to
database

Yes

Yes

Figure 9.22  Incoming call to TELES.NMS
89

vGATE 14.0. Revised: 21 July 2008.



N M S  T E S T I N G ,  P O L L I N G  A N D  S U P P O R T  P R O C E D U R E S

C H A P T E R  9
Whether or not calls to the NMS polling and support numbers are accepted depend on several factors described in
the following table. If any one of these conditions is true, the call is accepted and operations are carried out as
illustrated in Figure 9.22 .

Table 9.28  NMS Call Acceptance Factors

Factor

1. Was the call placed to the support number?

2. Has the Update Table flag been set for this system?
(Defined in the Change Flags dialog available from the Update View context menu – see 
Chapter 6.19 on page 55 .)

3. Is the Update Routing Table option active for this group?
(Defined on the Groups tab of the NMS Desktop Properties dialog described in Table 
6.12 .)

4. Is the Send Default Table option active for this group?
(Defined on the Groups tab of the NMS Desktop Properties dialog described in Table 
6.12 .)

5. Is the Get Statistics option active for this group?
(Defined on the Groups tab of the NMS Desktop Properties dialog described in Table 
6.12 .)

6. Has the Always Accept Call flag been set for this system?
(Defined in the Change Flags dialog available from the Update View context menu – see 
Chapter 6.19 on page 55 .)

7. Is the Always Accept Call option active for this group?
(Defined on the Groups tab of the NMS Desktop Properties dialog described in Table 
6.12 .)

8. Is the Update remote access numbers flag set for this system?
(Defined in the Change Flags dialog available from the Update View context menu – see 
v.) 
This factor only applies to TELES.iLCR 1 BRI, 2BRI, iLCR 4BRI-IP Boxes and 6BRI Boxes and 
iLCR PRI Boxes.

9. Is Accept call if system is unknown active for this group?
(Defined on the Groups tab of the NMS Desktop Properties dialog described in Table 
6.12 .)
This factor is only considered if the calling system does not identify itself with a calling party 
number.
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After an incoming call is accepted, the NMS Listen application must search the database to determine which system
is calling in order to determine the appropriate actions. Depending on the information provided with the call, the
database can be searched either by Calling Line Identification (CLI) or by serial number. The following table shows
when each of these methods is used. There are four different possibilities. For each possibility, the information pro-
vided (CLI and/or serial number) is marked with an “X”.

Once an incoming call is accepted and the system has been found in the database, the operations performed de-
pend upon the type of system calling. 

Table 9.29  NMS Database Search Criteria

CLI SN Result

1. If neither CLI nor serial number are included with the incoming call, 
the database cannot be searched and the call is rejected.

2. X Search database by serial number

3. X Search database by Calling Line Identification

4. X X If the Always search for base number option has been marked in 
the NMS Listen startup dialog, the database will be searched by Call-
ing Line Identification. If this option is not active, the database will 
be searched by serial number.
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Table 9.30  lists the procedures carried out for each system type.

Once the operations described in Table 9.30  above are completed, the NMS database is updated to reflect the
changes. The changes made to the database depend on the conditions described in the following table. 

Table 9.30  NMS Operations Performed on each System Type 

System Type Operation

All systems 1. Get system info

Box-based systems 1. Pick up and parse event log (in case of errors) 
2. If the table is sent (in case of emergency; if flag is set in case of 

polling):
- Pick up current routing table from box
- Convert table from BIN to ASCII format
- Merge new routing info with box configuration (see Chapter 8.1 
on page 82 )
- Change remote number if necessary
- Convert table back to BIN from ASCII format
- Send new table back

3. Send time if necessary (if requested by box, or if flag has been set)
4. Pick up statistics data (only if flag in Group Properties has been 

set)

PC-based systems 1. Pick up event log (protocol.log) and parse for errors
2. First-generation systems only: If the table is sent (if flag is set): 

- Get routing information (route.cfg) and parse for extern 
files
- Send routing information and extern files

3. Second-generation systems only: If the flag is set, the 
route.cfg is sent.

Table 9.31  Conditions Resulting in NMS Database Activity

Condition Database Activity

With all incoming calls Log last contact time

With all connections Update system information

If routing table is updated Log last update time, reset Update Table flag

If errors have occurred on the system Log last error message

If statistics data is downloaded from system Update statistics in database
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9 . 1 1  TE S T I N G  S Y S T E M S  I N  G R O U P S

To organize tested systems into groups, assign them to the same group by selecting the desired group from the list
provided on the System tab of the NMS System Editor, or by dragging the network element’s icon and dropping
it on the desired group icon in the NMS Group View.

Network elements may be organized into functional groups with the help of the NMS Filter tool and so-called “Dy-
namic Groups”. See Chapter 6.8  for more information on this concept.

The dynamic groups may also be used to collect systems for assignment to the standard NMS groups. To do so,
define a query and then drag the displayed systems from the NMS Filter View window to either the desired group
icon or into the corresponding Group Full View window. If necessary, use the NMS Desktop Properties dialog to
rename existing groups or create new ones.
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1 0 . 1  U P D A T I N G  F I R M W A R E

As new firmware versions often introduce new commands to the configuration, or change the way in which existing
commands are interpreted, TELES recommends editing the configuration files of the systems that are to be updated
before the new software is installed on the network elements.

Use the Change/Get Files Tab  of the NMS Jobs tool to define a job that will alter the configuration as neces-
sary. Depending on the existing software version and the version you will be updating to, it may be necessary to
change, add, or delete lines in the existing configuration before installing the new software.

Once this step is complete, you may then run a second job that uses the Update command to install the new soft-
ware on the selected network elements.

1 0 . 2  M O N I T O R I N G  S E V E R A L  B O X E S  O N  A  S I N G L E  I S D N  L I N E

If several older iLCR 2BRI Boxes are connected to the same ISDN line (configured for Point-to-Point operation),
NMS would not normally be capable of distinguishing one box from the next during incoming polling calls, as each
would send the same Calling Party Number (CgN).

In order to use TELES.NMS to monitor boxes operating under these circumstances, it is necessary to assign the box-
es to a separate group that participates in update management and for which the Always accept call flag is set
on the Group Properties tab.

Thus configured, NMS will always accept polling calls from these systems, download the serial number from the
calling system and search the database for an entry with this serial number. In this fashion, NMS can locate the
corresponding database entry, or create a new entry with the Calling Party Number and an additional index based
on the serial number to uniquely identify the network element and distinguish it from the other boxes calling in
from the same line.

For newer boxes (as of version 4.5), this workaround is no longer necessary, as the NMSPollCLI command may
be used to send the serial number in place of the calling party number as calling line identification.

1 0 . 3  R E M O V I N G  T H E  S O F T W A R E  

The TELES.NMS software can be removed using the Add/Remove Programs Control Panel. Select the
TELES.NMS entry from the list of applications and press the Add/Remove button. Any files created after installa-
tion in the NMS directories (new databases, etc.) must be manually removed.

1 0 . 4  I N S T A L L I N G  T H E  T E L E S . N M S  C L I E N T

You can install the TELES.NMS client to access and administer network elements from a remote desktop.

The installation process consists of the following steps:

1. Install MyODBC drivers
2. Install TELES.NMS client software 
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The following preparations are necessary in order to operate the TELES.NMS client software:

Set up NMS database as System DSN (see Chapter 10.4.3 on page 96 )

Share directory for common files (see Chapter 8 on page 81 )

Set system preferences for NMS Desktop (see Chapter 6.1 on page 41 )
The client software can be installed on a PC running Windows NT, Windows 2000 or Windows XP.

The client PC must be connected to the TELES.NMS server with an Ethernet connection of at least 10 MB.

1 0 . 4 . 1  I N S T A L L I N G  T H E  M Y O D B C  D R I V E R S

Install the software from the CD included in the package contents. Select Install MyODBC. Accept the License
Agreement and follow the instructions provided on your screen. 

1 0 . 4 . 2  I N S T A L L I N G  T H E  T E L E S . N M S  C L I E N T  S O F T W A R E

When you have finished installing the MyODBC software, you may proceed with the installation of the TELES.NMS
client software from the same CD.

The following modules are included in the client software:

Configuration (advanced)

Configuration (client)

Desktop
EventManager

EventViewer2

Jobs
UserManager

Follow these steps to install the software:

Select Install NMS. 
Click Next and Browse or Next
to select an directory for the
software. 

Continue to click Next until you
reach the Setup Type menu. 

Select NMS Client.
Answer each query and click
Finish.
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1 0 . 4 . 3  S E T T I N G  U P  D A T A  S O U R C E S  W I T H  S Y S T E M  D S N S

MySQL Server

To set up a database on a MySQL server as a System DSN, proceed as follows:

1. Start the NMS Configuration (advanced) tool. Press the New button to create a new ODBC data
source.

2. From the resulting dialog, select the MySQL Database option.
3. A wizard appears to help you cre-

ate an ODBC data source that you
can use to connect to a MySQL
Database. On the Login sheet of
the MySQL Database DSN Con-
figuration window, enter a name
for this data source and the
Server’s IP address. Enter
nmsuser in the User field and
nms in the Password field. Select
NMS Database from the Data-
base list. 

4. On the Advanced sheet, Flags 1,
activate the following checkboxes:
– Don’t Optimize Column Width

– Return Matching Rows

– Allow Big Results
– Change BIGINT Columns To Int

5. Click Test
6. Success; connection was

made! must appear. Click OK.
7. Click OK in the ODBC Connector to

finalize the database connection.

1 0 . 4 . 4  T E L E S . N M S  C L I -
E N T  C O N F I G U R A T I O N  

Before configuring the TELES.NMS client, you must disable TCP filtering on the TELES.NMS server. Enable TCP fil-
tering again following configuration unless you have installed the GATE Manager on the client. In this case, be sure
to secure the network with a firewall. Network data transfer with the GATE Manager cannot occur if TCP filtering
is active. 

To disable TCP filtering, right-click My Network Places, select Properties, right-click LAN-1, select Proper-
ties, mark Internet Protocol (TCP/IP) and click Properties. In the window that appears, click Advanced. An-
other window appears. On the Options sheet, mark TCP/IP filtering and click Properties. In the window that
appears, activate Permit All above the TCP Ports column OK.
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To access the TELES.NMS applications from a re-
mote client, you must first configure the connec-
tion to the TELES.NMS server as follows: 

1. Open NMSConfiguration (advanced).
2. Click the Network tab.
3. Enter the IP address of the NMS server in

the Server name field.
4. Click the Security tab.
5. Under Database, click SQL Server inte-

grated, enter nmsuser in the Username
field and nms in the Password field.

6. Click the Directories tab.
7. Click Browse All.
8. Select the nms_data directory from the

NMS Server in your network and click OK. If
your network does not have a DNS server,
enter the NMS server’s IP address here in
the following format:
\\192.168.1.1\nms_data

9. A message appears, telling you that you
have selected a directory that you cannot
access over the network. Click OK.

The client is now configured.

The server’s IP address must be entered on the NMSConfiguration (advanced) appli-
cation here: NMS Configuration | Network| Server. You must then restart the NMS 
server.

ii
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1 0 . 5 . 1  O N  A  W I N D O W S 2 0 0 0  P R O F E S S I O N A L  S E R V E R

IF you are updating from a version before TELES.NMS Version 6.1, please contact the TELES service department for
assistance. To update from a later version, follow these instructions:

Shut down the TELES.NMS server and close all TELES.NMS applications. Uninstall the old version of
TELES.NMS. 

Stop the WinMysqlAdmin Service by right-clicking the  icon in the right-hand corner of the taskbar
and selecting WinNT -> Stop the Service from the context menu. The traffic light will then turn red.

Restart the WinMysqlAdmin Service by selecting WinNT->Start the Service from the same context
menu, so that the traffic light turns green.

Start the MSDOS command prompt at Start | Programs | Accessories | Command Prompt
Enter D: and press Return
Enter cd mysql\bin and press Return
Enter mysql -u nmsuser -p and press Return
Enter password:nms and press Return
Enter the command \. (backslash period space) and enter the path to the script (in this example, on the
D: drive):
D:\TELESNMS\Database\MyDiff_60_70.sql
Press the Return key

Enter exit to exit mysql

Stop the WinMysqlAdmin Service by right-clicking the  icon in the right-hand corner of the taskbar
and selecting WinNT -> Stop the Service from the context menu. The traffic light will then turn red.

Restart the WinMysqlAdmin Service by selecting WinNT->Start the Service from the same context
menu, so that the traffic light turns green.

Start NMS Advanced Config and check your settings!
Now you can restart the TELES.NMS server and all TELES.NMS applications.
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1. Uninstall TELES.NMS

– Select 
Add/Remove Programs from 
Programs / Control Panel.

– Uninstall Teles.NMS with Re-
move.

– Confirm with Yes.

– Select YES To All...

– End with OK.

2. Uninstall WinRemote from the
workstation the same way
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1 0 . 5 . 3 . 1  I N S T A L L I N G  O N  A  S E R V E R  O R  A L L - I N - O N E

To install NMS, follow these steps:

Put the NMS CD into the CD
drive. 
If it is not already installed,
install Internet Explorer 6.0. It is
included on the CD.

Select Install NMS. The
Welcome... 
dialog appears. 
Click Next.
Choose the destina-
tion folder
D:\Telesnms. 
Click Next.
Set the NMS data path to
D:\Telesnms\nms_data. 
Click Next.
If installing on a combined
server and workstation, select
NMS All In One the Setup
Type dialog. If installing on a
stand-alone server, select NMS
Server.
Click Next. Confirm Program Folder TELES.NMS. 
Click Next.
Do you want to create icons on the desktop? 
Click Yes.

Confirm the following 2 registry information messages with OK.
Setup is finished. 
Select Yes, I want to restart my computer now. 
Click Finish.
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To install NMS on a stand-alone workstation, follow these steps:

Put the NMS CD into the CD
drive. 

Select Install NMS. The
Welcome... 
dialog appears.
Click Next.
Choose the destination folder
D:\Telesnms. 
Click Next.
Set the NMS data path to
D:\Telesnms\nms_data. 
Click Next.
Choose NMS Workstation
from the Setup Type dialog. 
Click Next.
Confirm Program Folder
TELES.NMS. 
Click Next.
Do you want to create icons on the desktop? 
Click Yes. 

Confirm the following 2 registry information messages with OK.
Setup is finished. Select Yes, I want restart my computer now. 
Click Finish.
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To set up an ODBC link to a new database, follow these steps:

Start the NMS Configuration
(Advanced) module by double-clicking
its icon on the desktop. 

Press the New... button to create a new
ODBC data source.

From the resulting dialog, select the MS
SQL Server option. 

A wizard appears to help you create an
ODBC data source to connect to the SQL
database.

Enter a name for this data source in the
box provided. Specify the name of the
SQL Server you are setting up. You can
select a server from the list or enter the
server name manually. 
Click Next.

Click Next again. 

Check Change the default database
to to select the new NMSDatabase
name. Click Next and then click Finish. 

Finally, click OK.
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Other NMS settings
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 On the Directories tab of the NMS
configuration dialog, click the Browse
Share... button and select the
\\NMSServer\nms_data directory. Click OK.
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To copy the old database into the new database, follow these steps:

Start NMS Database Copy and copy
the old NMSDatabase into the new
NMSDatabase.
After selecting the Source and
Destination database. Click the
Copy Database button.

Confirm with Yes.

After successfully copying the
database, end the dialog with
Cancel.

The NMS software can now be
started as usual.
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